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Copyrights and Trademarks

Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows 7, Windows 8, and Windows 10 are registered trademarks of Microsoft
Corporation in the United States and/or other countries.

Other product names used herein are for identification purposes only and may be
trademarks of their respective companies. We disclaim any and all rights to those marks.

Warranty

The information contained in this document(s) is subject to change without notice.

The manufacturer makes no warranty of any kind with regard to this material, including,
but not limited to, the implied warranties of fitness for a particular purpose.

The manufacturer shall not be liable for errors contained herein or for incidental or
consequential damages in connection with the furnishing, performance, or use of this
material.

Safety Information

When using this equipment, the following safety precautions should always be followed.

Safety During Operation

In this manual, the following important symbols are used:

/N WARNING:

Indicates potentially hazardous situations, which if instructions are not followed, could
result in death or serious injury.

/N CAUTION:
Indicates a potentially hazardous situation which, if instructions are not followed, may
result in minor or moderate injury or damage to property.

Important:
Indicates operational requirements and restrictions. Please read and follow these
instructions to ensure a proper operation and to avoid damage to the machine.

Note:
Indicates further explanation or clarification. Reading this is highly recommended.

/N WARNING:
To avoid hazardous electric shock or fire, do not remove any covers or screws other than
those specified in this manual.

/N CAUTION:

v To reduce the risk of fire, use only no.26AWG or larger telecommunication line cord.

4 Disconnect the power plug by pulling the plug, not the cable.

v Do not touch the metal fingers of the ADF pad module. The edges are sharp and
touching them may result in injury.



Precautions

. Do not install the equipment near heating or air conditioning units.

. Do not install the equipment in a humid or dusty place.

. Place the equipment securely on an even, flat surface. Tilted or uneven surfaces may
cause mechanical or paper-feeding problems.

. Retain the box and packing materials for shipping purposes.

Federal Communications Commission (FCC) compliance information
statement
Part 15

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications.

However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

e Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) This device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired
operation.

C€

European Union Regulatory Notice

Products bearing the CE marking comply with the following EU Directives:

° Low Voltage Directive 2014/35/EC

® EMC Directive 2014/30/EC

® Restriction of the use of certain hazardous substances (RoHS) Directive 2011/65/EU
® RED (Radio Equipment Directive) (2014/53/EC)

CE compliance of this product is valid if powered with the correct CE-marked AC adapter
provide by Avision.

This product satisfies the Class B limits of EN55032, EN55035, and safety requirements of
EN62368-1.

*This machine is certified as Class 1 LED product.



*Note the operating temperature for the battery is from -20° to 60° C. And the operating
temperature for the product is from 10° to 35° C.

If the operating temperature for the battery is outside the range of -20°~60° C, it may
cause cracking, rupturing, bursting, emission of flame or expulsion of molten metal to the
outside of the equipment enclosure.

Product Safety Guide

Please clearly read all these instructions, and follow all instructions and warnings before
installing and using the device.

The following indications are used in this document to obviate any chance of accident or damage
to you and/or the device.

N WARNING Indicates potentially hazardous situations, which if instructions are not

followed, could result in death or serious injury.

/N CAUTION Indicates a potentially hazardous situation which, if instructions are not

followed, may result in minor or moderate injury or damage to property.

/N\ WARNING

B Use only the AC power adapter that came with your device. Using any other AC power
adapter could cause fire, electrical shock, or injury.

B Use only the AC power cord and USB cable that came with your device and avoid abrasions,
cuts, fraying, crimping, and kinking. Using any other AC power cord and USB cable could
cause fire, electrical shock, or injury.

[ | Do not place objects on top of the AC power cord, and do not allow the AC power adapter
or the AC power cord to be stepped on or run over.

| Place the device and its AC power adapter near an electrical outlet where the AC power
adapter can easily be unplugged.

B If you use an extension cord with the device, make sure that the total ampere rating of the
devices plugged into the extension cord does not exceed the cord's ampere rating.

| Place the device close enough to the computer so that the interface cable can easily reach
between the device and the computer.

| Do not place or store the device or its AC power adapter:

e Outdoors

e Near excessive dirt or dust, water, or heat sources

e In locations subject to shocks, vibrations, high temperature or humidity, direct
sunlight, strong light sources, or rapid changes in temperature or humidity

| Do not use the device with wet hands.

[ | Never disassemble, modify, or attempt to repair the AC power adapter, device, or device
option by yourself, except as specifically explained in the device's documentation. This
could cause fire, electrical shock, or injury.

u Do not insert objects into any opening, as they may touch dangerous voltage points or
short-out components. Beware of electrical shock hazards.

B Unplug the device and the AC power adapter, and refer servicing to qualified service

personnel under the following conditions:

° The AC power adapter or plug is damaged.

° Liquid has entered the device or the AC power adapter.

° Object has entered the device or the AC power adapter.

° The device or the AC power adapter has been dropped, or the case has been
damaged.

° The device or the AC power adapter does not operate normally (i.e. appearance of
smoke, strange smell, odd noise, etc.), or exhibits a distinct change in performance



B Unplug the device and the AC power adapter before cleaning.

/N CAUTION:

B Do not attempt to operate the product in temperature outside the range of -20°~60° C.
If so, this may cause cracking, rupturing, bursting, emission of flame or expulsion of
molten metal to the outside of the equipment enclosure.

Note the the operating temperature for the battery is from -20° to 60° C and the
operating temperature for the product is from 10° to 35° C.

B Do not locate the device on rackety or aslope tables. Do not locate the device on unstable
surface. The device may fall down and this may result in injury.

B Do not place heavy objects on the unit. It may cause unbalance and the device may fall
down. This may result in injury.

B Store the AC Power cord/USB cable bundled out of the reach of children to avoid the risk of
injury.
B Keep plastic bags bundled out of the reach of children to avoid the danger of suffocation.

B If you are not going to use the device for a long period, unplug the AC power adapter from
the electrical outlet.

Disposal of Waste Equipment by Users in Private Union
|

This symbol on the product or on its packaging indicates that the product can not be
disposed of with your other household waste. Instead it should be sent to appropriate
facilities for recovery and recycling in an effort to protect human health and the
environment. Fore more information about where you can drop off your waste equipment
for recycling, please contact your local city office, your household waste disposal service or
the shop where you purchased the product.

As an ENERGY STAR® Partner, Avision Inc. has determined that this
product meets the ENERGY STAR guidelines for energy efficiency.

i)

ENERGY STAR

System Requirements
CPU: Intel® Core™ 2 Duo or higher

Memory: 32 bit: 2 GB
64 bit: 4 GB

Optical Drive: DVD-ROM Drive
USB Port: USB 3.2 Gen 1x1 (compatible with USB 2.0)

Compatible Windows 10 (32 bits/64 bits), Windows 8 (32
Operating bits/64 bits), Windows 7, Windows Vista,
System: Microsoft Windows XP(SP3)



1 Getting Started

Introduction

Thank you for purchasing the network scanner. With the product, you can
instantly scan single-sided or double-sided document(s) and deliver the electronic
images to various destinations including E-mail addresses, ftp servers, network
folders such as FTP, FTPS, FTPES, or cloud servers such as Google Drive,
Evernote, OneDrive, or Microsoft SharePoint. In addition, the product also allows

you to save the scanned image to an inserted USB flash drive, or the product’s
own memory.

If required, the product can be used as a regular scanner through USB or wired
network connection to start a scan with your TWAIN-compliant software
application and optimize your scanned images with various advanced image
enhancement tool. You may refer to Chapter 7 Using the Product As a Regular
Scanner in this manual on how to use this function.

Various Scan to Destinations

Scanning and Sending Your Images to an E-mail address:

Connected to an ethernet network and a SMTP server, the product allows you to
transmit document(s) to your E-mail as attachment. With a touch of the E-mail
key and the selection of your recipients' E-mail addresses, the document(s)
is/are first scanned and converted into an image file, and then transmitted to
remote recipients within minutes.

Scanning and Sending Your Image to a Cloud server or Network Folder:
The product allows you to send the scanned documents to a server such as
Google Drive, Evernote, SharePoint Online or a network folder over intranet with
FTP (File Transfer Protocol), FTPS (FTP Secure), FTPES, SharePoint, or SMB
(Server Message Block Protocol). This feature off-loads the mail server from
handling large attachments.

Scanning and Saving Your Images to a USB Flash Drive:
By plugging a USB flash drive into the USB port of the product, the product

allows you to scan your document and save the scanned images to your USB
flash drive.

Scanning and Saving Your Images to the Product’'s Memory:

By selecting a public folder as a filing destination, the product allows you to scan
and save the scanned image in the product’'s memory and access the file from
the product’'s embedded web page.



Preview:

Before sending your documents over the network, the product allows you to view
a reduced size of the scanned document to verify if the scanned image has
been skew, or upside down. If one of the pages is skew, you can delete and
rescan that page to save your time.

Scancast:
Scan and broadcast the images respectively to various destinations including a

cloud server, a public folder (the product’s memory), a USB flash drive, E-mail
addresses, a file server on the network such as FTP ~ FTPS - FTPES, SMB.

Using Convenient Shortcuts:

By assigning your frequently used settings and scan to destinations as Shortcuts,
the product allows you to streamline your workflow and complete your scanning
task in just one press of a button.



Package Items

Scanner Main Unit

ADF Paper Tray

Ethernet Cable

Software CD/Quick Guide
USB Cable

Power Adapter & Power Cord

1.
2.
3.
4.
5.
6.

Note:

1. Only use the AC adapter DA-48M24 by APD included in the machine.
Using other AC adapters may damage the machine and void the warranty.

72 Please unpack the packing carefully, and check the contents against the
checklist. If any items are missing or damaged, please contact your
dealer immediately.

3. To access more service supports, visit www.avision.com to register your
Avision’s product.



http://www.avision.com./

External View

The Front View

Extension

Paper Guide

ADF Paper Tray \

LCD Touch Panel Paper Guide

The Power Button

Paper Stopper

Document Cover

Part Name Function

Extension Can be pulled out and adjusted to the size of the
document being scanned.

ADF Paper Tray Load the document onto this part when scanning
document.
Paper Guides Adjusts to the width of the documents to prevent

skewing of the scanned pages.

LCD Touch Panel Operate the scanner through the touch screen.
Power Button Press to turn on the power.

Document Cover Open it to place the document on the glass platen.
Paper Stopper Adjust to the length of the documents to prevent

them from falling apart.




The Rear View

/ Power Connector

Kensington ~{|
Security Slot

LAN P
USB Port ort
l |
Part Name Function
LAN Port Connect the scanner to network with a LAN cable.

Power Connector | Connect the AC adapter to the scanner.

USB Port e Connect to your computer via the supplied USB
cable to use the device as a regular scanner.

e Connect to your computer via the supplied USB
cable to download firmware if required.

Kensington Attach to a lock to secure the scanner.
Security Slot




The Side View

USB Flash

Function

Used to insert a USB flash drive.

Part Name
USB Flash Drive

Removable Parts

Reverse Roller




Pre-installation Information

Preinstallation

The product has to be setup properly on your network to perform E-mail and

filing functions. The following network parameters have to be set.

Important!

Make a copy of the following table and ask your Network Administrator
to complete the information.

1. DHCP Enable:

2. IP Address:

3. Subnet Mask:

4. Gateway IP:

5. DNS Server:

6. WIN Server:

7. SMTP Server

8. SMTP Port: 25
0.

LDAP Server:
10. LDAP Port:

Explanation of contents:

1. *DHCP Enable: Choose Yes to obtain IP/subnet/gateway/DNS
server/WINS server addresses automatically
from DHCP server.

2. ¥*IP Address: The Internet Protocol (IP) address assignhed to
your machine by your network administrator or
by DHCP server.

3. Subnet Mask: The net mask address assigned by your
network administrator or by DHCP server.

4. Gateway IP: The gateway IP address assigned by your
network administrator or by DHCP server or by
DHCP server.

5. *DNS server: The IP address of DNS server assigned by your
network administrator.

6. *WINS Server: The IP address of WINS server assigned by
your network administrator.




7. *SMTP Server: The IP address of your SMTP mail server
assigned by your network administrator.
8. SMTP Port: The port number of your SMTP Mail Server.
9. *LDAP Server: The IP address of your LDAP server.
10. LDAP Port: The port number of your LDAP server.
Note:
1. DHCP server: With DHCP (Dynamic Host Configuration Protocol), a host can

automatically be given a unique IP address each time it connects to a
network--making IP address management an easier task for network
administrators. If the DHCP server is available from your network, you do
not need to enter TCP/IP, subnet mask, gateway, and DNS information.
Instead, this information will be automatically given for the product.

IP Address: An IP (Internet Protocol) address uniquely identifies a host
connection to an IP network. System administrator or network designer
assigns the IP address. The IP address consists of two parts, one identifying
the network and the one identifying your node. The IP address is usually
written as four numbers separated by periods. Each number can be zero to
255. For example, 10.1.30.186 could be an IP address.

DNS: Stands for Domain Name System. The DNS server identifies hosts via
names instead of IP addresses. If the DNS server is available on your
network, you can enter the domain name instead of digits for the IP
address.

. DNS: Stands for Domain Name System. The DNS server identifies hosts via

names instead of IP addresses. If the DNS server is available on your
network, you can enter the domain name instead of digits for the IP
address.

. WINS: Stands for Windows Internet Naming Service. WINS resolves

Windows network computer names (also known as NetBIOS names) to
Internet IP addresses, allowing Windows computers on a network to easily
find and communicate with each other.

LDAP: Stands for Lightweight Directory Access Protocol. LDAP enables users
to access directories and address books directly from external networked
devices to simplify document distribution.




Frequently Used Buttons on the Touch Screen

The following table lists the frequently used buttons and their functions on the
touch panel:

The [Start] button:

Choose to start scanning the document and sending the

scanned image to E-mail, Public Folder, USB Flash Drive, or
other destinations.

The [Back] button:

Choose to leave current screen and return to previously
operational screen.

The [Home] button:

Choose to leave current screen and return to the main
operational screen.




2 Installing Your Machine

This chapter is specifically targeted to the persons who are responsible for the

administration of the product. It is recommended that the administrator read this
chapter before installing the machine.

Minimum Configuration Requirements
To use the product as a network scanner, the following configuration is required:

To send E-mails from the product:

e TCP/IP network
e A Mail server

To file document(s) via intranet

e FTP, FTPS, FTPES, or SMB protocol environment

10



Installing the ADF Paper Tray

Hold the ADF Paper Tray and insert two pins to the holes on the top of the

1.

scanner as shown.

>
©
jo.
T
|-
(]
Q
©
o
L
o
<

Pull out the extension to the length of the document.

2.

Raise the paper stopper to prevent the paper from falling.

3.

Adjust the Paper Guide to fit your document size.

4.

11



Connecting the Cables

Connecting the Ethernet Cable

1. Connect one end of your Ethernet LAN cable to an available port of your
Ethernet Hub.

2. Connect the other end to the port marked % at the back of the product.

L

WUy

Connecting the Power and Turning on the Machine

1. Connect one end of the power cable to the power receptacle of the product.

2. Connect the other end to an appropriate power outlet.

12



3. Press the [Power] button to turn on the product. The Power LED lights
up in green color and in a second the LCD Touch Panel will be displayed

with a Home screen as illustrated.

Avision

Note:

If the product will not be used for a long time, press the Power button for 3
seconds to turn off the power. Then unplug the product from the power
outlet.

Turning Off the Machine

1. Press the Power button for at least 2 seconds. A Confirmation dialog box

appears.
Power off

Reboot

2. Tap [Power off] to turn off the machine or reboot to restart the machine.

Power off

The machine is going to power off.

Cancel (0] ¢

3. Tap [OK] to turn off the machine.

13



Selecting Your Language

The product provides various languages on the LCD Touch Panel. Choose your
desired language to be displayed on the LCD Touch Panel.

1. Press the [Power] button to turn on the product. The LCD Touch Panel will

be prompted with a Home Screen as indicated.

1P-10.1.2063 Nov 9, 2015 10:43:21 AM

—_—
)
USB Flash Public Folder
il 2
Ens Color Color
e 300dpi 300dpi
M-PDF M-PDF

Ce]

2. On the LCD Touch Panel, tap [Settings]> [Device Management]

>[Language] in succession and then choose your desired language.
Choice : English, Chinese Traditional, Chinese Simplified, Spanish,
Portuguese, Hebrew.

Device
Management

2 H: P
D?VICQ 'x‘

Management E-Mail Default,
a——

iy

Filing Profiles.

B seenre - e

@ Device E-mail Address

— English
Eﬁz Reset to User Default

o nMay
: o Auto add contact to address book

3T ()

i,
r_-g.—_Br_wgl_\meE —-—— = —
I P ()
l 3 Language
—-—e— e m— mm = = ’
8" Admin. Profile

Cancel

3. Tap [Save] to save the setting.
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Setting Date and Time

To let the product show current date and time, please set your date and time for

the product before using it.

1. On the Home Screen of the LCD Touch Panel, tap [Settings]>[Device

Management]>[Date] in succession and then set your current date.

Device
Management

- ===

e I o
2 - -
A E w
I - 'x<
| Management Sl | Network £-Mail Defal Filing Default

» —-— -

/S —— e Ar—  —
oot : et g
[ H‘ Sherteut ) E
Filing Profiles. Address Book Shortcut Service Mode

CJ! — |
Cancel I\ save | ,

‘ Host Name

(‘Z«\% NTP Server

2015 Nov 09

@ Time Zone
@ Power Saving

@ Auto Power OFF

Cancel

2016 Dec 10

2. Tap [Save] to save the setting and go back to the previous screen.
3. On the [Device Management] screen, tap [Time] to set your current time.

4. Tap [Save] to save the setting and go back to the previous screen.

15



Specifying the Product’s TCP/IP Address

To let other devices on the network identify the product, you need to set an IP

address for the product. Follow these steps to set an IP address:

1. On the Home Screen of the LCD Touch Panel, tap
[Settings]>[Network]>[Wired] in succession and then set the IP address

for the product.

B0
® r==

= 24 ,
Cloud (=] i !
s o o
;‘ USB Flash Public Folder m::;::cm Namolk
—f Settings | s ——
I M-PDF /T’ » l N ) b
- Tem [ | » L K
L (A= \ Filing Profiles M Address Book Shortcut Service Mode

e o e e _ B (=) =)
5 «X - S—

—_—em = = = == = -
Wireless Client @ DHCP Static 1P L)wsul:\({ 802X EAP |
@ AP Mode Settings 1P address 101.2080
9 Mail Server Subnet Mask 256.255.255.0
| Gateway address 10.1.20254
LDAP Server | |
’ DNS address 10.1.90.115 ‘

=&l Credential Manager
MAC address 000232013881

Cancel

- Check [DHCP] if you wish to enable DHCP.

- Check [Static IP] if you wish to specify a static IP address. If [Static
IP] is selected, tap the IP Address/Subnet Mask/Gateway
IP/DNS Server field respectively to bring up the soft keyboard and
then enter the relevant values.

2. Tap [Save] to save the setting and go back to the previous screen.

Note:

e If the system administrator has chosen DHCP, then the IP address of TCP/IP,
gateway, subnet mask, and DNS server will be automatically given.

e When installing the product for the first time, it is recommended that the
Administrator retain the default system settings. The settings can be
customized at a later date once you are familiar with the operation and
functionality.
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Specifying the Product’s Mail Server

To send the scanned image to a recipient via E-mail, you need first specify your

mail server information on the product. Follow these steps to set your mail
server:

1. On the Home Screen of the LCD Touch Panel, tap

[Settings]>[Network]>[Mail Server] in succession and then set your
mail server information.

Avision

Settings

P
-] X

Device
Management

) =
& -~
9
-
Network -Mail

|
|
|

-
ol BB =Y B
Filing Profiles Address Book Shortcut Service Mode

2006047711354
Network

® e—=rTanl
i’i Wired Mail Server L L_ =D
@ Wireless Client @

Mail Server
@ AP Mode Settings
=

[10.1.90.150
|

Port# |25
E Mail Server I Authentication Method 0 )
— ﬂA-EDRPSEHEI- —_— Encrypt L None ﬂ
& : _> Login Name
=&} Credential Manager o ‘ ‘

Password [
Cancel

On the Mail server option, enter the IP address and port number of your
mail server.

On the Authentication Method option, tap [ON] to enable it or [OFF]
to disable it.

Tap anywhere respectively on the Login Name/Password/Mail

Server/ Port# field to bring up the soft keyboard and then enter the
relevant values.

2. Tap [Save] to save the setting and leave the screen.
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Creating Your Address Book

To save the time in typing the E-mail address, you can create your address book

to speed up the process.

1. On the Home Screen of the LCD Touch Panel, tap [Settings]>[Address

Book]>[New] in succession and then enter your address information.

Avision

G
e
¥
Device
Management

Account
Management

-

Filing Profiles. Address Book

| S —

New Contact

[ Personal > q‘ ' & I& P N
- [ Name I
nimo_wei nimo_wei@abc.com I [ ] I
| E-mail Address I
H{ J

|
i Description 1
L )%

| I I

Cancel Save
-_-—J

2. Tap [Save] to save the setting and leave the screen.
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Creating Your Filing Profiles

To store your scanned image to the network folders, you need to first set up a
few network folders including FTP, FTPS, or SMB to store the images.

1. On the Home Screen of the LCD Touch Panel, tap [Settings]>[Filing

Profiless]>[New] in succession.

1P-10.1.20.63 Nov 9, 2015 10:4321 AM

Avisi
Cloud 9 = |
‘?“ Filing 'ﬁ
Management Profiles Filing Default
q >.. p=— =N

| ﬁ '_> e ; "b

[\ Filina ﬁ | I
FdimPloﬁln J Address Book_ Service Mode

Settings >> Filing Folder

“Profile Name File Name ——
| [Ex:DOC_#Y#M#D#hEmESHEN \
-—

FTP_PC A Scanto Output Color I

I [Frear B3 () cotor B

FTP_NB - Target URL Document Sides I "
— \

Filing_PC | - » . F.Down |>

F 4 Port# Passive Mode File Format I
iling_NB e — N
’ 21 @ ) (GaNZ3] > I
Login Name B Resolution
v | 200dpi N |
Password

\ ! /

2. Refer to the following table to create your Filing Profiles. Tap [Save] after

the settings have been made satisfactory.

Item Description
Profile Name Enter your profile name.
Scan to Choose your [Scan to] destination protocol.

Choice includes * FTP: //, FTPS: //, FTPES://,
SMB: \\, USB, Public Folder, SharePoint.

USB: Store the scanned image to an inserted USB
flash drive.

Public Folder: Store the scanned image to the
memory of the product and then access the image via
the product’'s embedded web page.

SMB: Store the scanned image to someone else’s
computer in the network over intranet.
FTP/FTPS/FTPES/SharePoint: Store the scanned
image to the network folder over intranet.
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Target URL

If FTPS, FTP, FTPES, SharePoint, or SMB is selected,
enter the URL address. You can either enter a domain
name or an IP address with the directory path. For
example, 10.1.20.25/test

Target URL

Enter the IP address of your scan to destination.

Port #

Enter the port number for the [Scan to] server.

Passive Mode

Set your FTP connection mode. Choice: On/Off
(default: Off).

Login Name

Enter your login name to use the designated folder.

Password

Enter your password to use the designated folder.

File Name

Enter your default file name.

Output Color

Choose your desired default output color for the
scanned image.
Choice: *Color, Gray, B/W

Document Side

Choose your desired default scanning side.
Choice: *1-Sided Face Down, 1-Sided Face Up,
2-Sided

File Format

Choose your desired default file format for the
scanned image.

Choice: JPEG, TIFF (One-Page TIFF), M-TIFF
(Multi-Page TIFF), PDF (One-Page PDF),
*M-PDF (Multi-Page PDF), Searchable PDF,
PDF/A(M-PDF), PNG

Resolution

The resolution is measured in pixels per inch (ppi)
(sometimes referred to as dots per inch or dpi).
Higher resolutions result in more detail in the scan,
slower scanning and in general, greater file sizes.
When OCR (Optical Character Recognition) is to be
performed on a scan, 300dpi should be used for most
languages except Asian languages. For Asian
languages, 400 dpi is recommended.

Resolution: 150 dpi

Resolution: 200 dpi

Note: If you are scanning duplex (two-sided) paper
in color mode, the max. resolution is 400 dpi.
Choice: 100dpi, 150dpi, *200dpi, 300dpi,
400dpi, 600dpi.

*: Factory default
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Installing and Launching a Plug-In App

This product makes user customization fast and easy by simply installing a
third-party app (short for application) to be run on the product. The new plug-in
app allows users to complete the scan tasks according to its own workflow.

Follow these steps to install the plug-in app:

1. Open your browser and enter the product’s IP address on the URL address.
The product’s embedded web page will be displayed.

2. Login the web page. (default user name and password: admin)

3. Tap [Device Management]>[Function Lock], and turn on the [App
plug-in] option. Tap [Update] to complete.

Admin|__ Logout _

B
Device Management . Update
nnn =
" H )

Genera

Scan to USB: On v
Scan to Public Folder: On v

4. The [App White List Setting] and [App Install/Unintall] options will be
displayed at the Menu items.

Mmin_Lquul

WebManager,
st

Device Management Update

General Function Lock A+ Manager

Scan to USB: [On v
Scan to Public Folder: [On v
App plug-in: [On

<

5. Tap [App White List Setting] from the Menu option and then tape
[Browse] to select the app name (in .spf file format) to be recognized by
the product. Finally, tap [Update] to complete.
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6.

Admin|___ Logout |

| WebManage,

L :
App White List Setting i vesme || i
..............
..............
App white list: . Browse.

Tap [App Install/Uninstall] from the Menu option and then browse the
installatio file of your app and then tap [Install]. If successful, the new
plug-in app will be displayed in the app list in below.

WebManagers
1ast
App Install/Uninstall

App Plug-in Install
App File (*.APK): Browse.. || Install
App Plug-in Uninstall

Action:| Uninstall |

App Plug-in Name

[ worldCard Team

< | <<[Page1(1/1)

Note:

If you wish to uninstall the plug-in app, simply select the app name from
the list and then tap [Uninstall]. The plug-in app will be uninstalled
accordingly.

How to run the plug-in app on the product:

1.

Install the plug-in app according to the steps described in the preceding
section.

2. On the product’s touch panel, tap [Settings]> [Device Management] >

D
W= o}
«

[Function Lock] in succession. Make sure the [App plug-in] is turned
ON.

Settings >> Device Management

Function Lock [ Cancel ] [ Save ]

Scan to USB

Scan to Public Folder

Virtual Scanner Link
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Scroll down the menu items on the right and then tap the [plug-in] icon.
Launch the app by selecting the name of app.

IP:10.1.20.64 2017/7/1317:33

Avision

USB Flash

Color
200dpi
Multi-page PDF

Color
200dpi
Multi-page PDF

Color
200dpi
Multi-page PDF

200dpi
Multi-page PDF

o)

*Plug-in app: Support Android OS version 4.4 or below.
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Setting the Plug-In App as the Default User
Interface

After installing your plug-in application, you can set the plug-in application to be
the default user interface after turning on the machine by the touch panel or the

embedded website.

To set the plug-in app as the default user interface on the Touch Panel,
1. Tap [Settings] on the touch panel and login with default user name and

password - admin.
2. Tap [Plug-in] and then [Set APP as Default UI].

: ]
o N
Management Nﬂllﬂfk E-Mail Defar Filing Default

amn
¢‘ "

———
)

)

Filing Profiles MM Address Book shwlu- pRTeN +, | plug-in ]

®agus®

3. Enter your application name in the [App Package Name] field and then tap
[Save] to complete.

Plug-in
SetAPP s | ‘ |
setAPP o @ ) [ concel ][ save |

App Package Name [ Exsom narmete myapgicaten |

4. Restart the machine. Your application’s user interface will be displayed.

To set the plug-in app as the default user interface on the website,

1. Open your browser and enter the product’s IP address on the URL address.
The product’s embedded web page will be displayed.

2. Login the web page. (default user name and password: admin)

3. Choose [App Install/Uninstall] from the Menu option and select the [Set
App as Default UI].

4. Check the [Enable] option and choose [Update] to complete.
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WebManagers

Information

Device Management

Network
Email Default
Filing Default
Filing Profiles
Address Book
Shortcut
Account Management
Firmware Update

Public Folder
Import/Export

App White List Setting

App Install/Uninstall

5. Restart the machine. Your application’s user interface will be displayed.

Apps Install/Uninstall

Apps Install/Uninstall

App Package Name:

Set APP as Default UI

RLLEITN
.
*
myapplication.apk E Enable 3 Update
., g

: 3 mple. licati
Ex:com.example.myapplication s, ¢
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Switching back to the Avision’s User Interface

If you want to switch back to the Avision’s (factory default) user interface, you

can disable your application from the product’'s embedded website.

To switch back to the Avision’s user interface,

1. Open your browser and enter the product’s IP address on the URL address.
The product’s embedded web page will be displayed.

2. Login the web page. (default user name and password: admin)

3. Choose [App Install/Uninstall] from the Menu option and select [Set App
as Default UI].
4. Uncheck the [Enable] button and choose [Update] to complete.

WebM. angk

Apps Install/Uninstall

Information

Device Management

Apps Install/Uninstall Set APP as Default UI

Network
------

Email Default »
X T
App Package Name: myapplication.apk » [J Enable M ‘ Update
s e
0

Filing Default

e
o 0
Filing Profiles Ex:com.example.myapplication "%+, .

Address Book

Shortcut

Account Management

Firmware Update
Public Folder

Import/Export

App White List Setting

App Install/Uninstall

5. Restart the machine. The Avision’s user interface will be displayed.
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Operation

Placing Your Document on the Flatbed

Open document cover. Place your document FACE DOWN on the document glass

and align the document to the reference mark as indicated. Close document cover.
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Document Loading Tips

Before using the ADF (Auto Document Feeder), please make sure that your
paper meets the following specifications:

° Document(s) can range in size from 50 x 50 mm (2 x 2 in.) (A8) to 216 x
356 mm (8.5 x 14 in.) (Legal).

o Document(s) can range in weight from 7 to 110 Ibs (27 ~ 413 g/m?)
° ID cards up to 1.25 mm (0.05 in.) thick
] Plastic cards compliant with the ISO7810 ID-1 type

(] Document(s) should be square or rectangular and in good condition (not
fragile or worn).

o Document(s) should be free of curl, wrinkle, tears, wet ink, or punch holes.

° Document(s) should be free of staples, paper clips, paper sticky notes.
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Loading Document(s) in the ADF

Fanning Your Document

Note: To avoid occasional multi-feeds or paper jams, please fan your

documents and align the top edges before feeding them into the scanner.

1. Hold both ends of the documents and fan them a few times.

2. Rotate the documents by 90 degrees and fan them in the same
manner.

3. Align the edges of the documents in a step-like pattern (see picture
below).

Step-like

i
1
i
i
[

Scanning
Direction

Document Feeding

Load the stack of document face down with the top of the pages
pointing into the feeder and verify that the paper guides are aligned with
the edges of the stack.
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Note: The [Paper Width] switch:

If your document width is 216 mm (8.5 in.):

If your document width is 216 mm (8.5 in.), slide the [Paper
Width] switch DOWN to fix your paper guide to conveniently
load the letter-size document.

If your document width is larger than 216 mm (8.5 in.):

If your document width is larger than 216 mm (8.5 in.) such as
invoices with punch holes, slide the [Paper Width] switch UP
and move the paper guide to the right end to load your
documents.

Slide DOWN the [Paper
Width] switch to set your
paper width to 216 mm

Slide UP the [Paper f
Width] switch to set ;
your paper width larger
than 216 mm (8.5 in.)
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Scanning a Stack of Document with Various Sizes

and Weights

When scanning a batch of documents with different sizes and weights, be

sure to follow the following guidelines to avoid a skewed image or a paper

jam:

1. Align the documents TOP EDGE first in the sequence of paper size from

large to small.

Ad

—3

JIr

X

2. If two pages are of the same size yet with different weight, arrange
these pages in the sequence of paper weight from heavyweight to

lightweight.

(127g) |

(60g)

(28g)

(65g) ]

(38g)

3. Align the edges of the documents by tapping the bottom of the stack
against the table top.

/2

—

b

Ab

IS

//
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4. Center these pages in the document feeder and make sure that the
edges of page of the largest size slightly touch the Paper Guide.
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Scanning and Sending Your Document to E-mail
Addresses

Basic Operation

Using the Default Setting

1. Load your document in the ADF with the 1% page facing down and the top of
the pages pointing to the feeder.

2. Press the E-mail button on the Home screen. The following
E-mail main screen will be displayed in the right side.

H 2016/11/16 09:06
E-mail
- Bl G
. E-mail Advanced Layout Bind JJi == 2\
o

Cc ‘ 0
p N Bce ‘
< , r
E-mail Document Sides Output Color
A/'éq » 1 -Sll;i:‘(:’:ace )] @ Color )]
Subject File Format

[Please enter email subject ] ﬂ@ MPDF ﬂ

Resolution
e B

3. Enter the E-mail address.

- Touch any place on the "To"” field (the empty box in the center) to bring
up the “soft keyboard” to type your email address. Tap the 2™ field to

enter your 2" E-mail address.
- You can delete the E-mail address by touching the [Delete] button after

you input your email address.

4. Enter or select CC and BCC address as well, if necessary. Enter the subject
of your E-mail via the soft keyboard. If not, the “"Default Subject” will be
displayed in recipients’ E-mail message.

5. Check if the Document Sides, Output Color, or File Format meets your
requirements. If not, change the settings to suit your needs.

Tap the [Start] button () to start a scan.

The product starts scanning and the preview image will be displayed.
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m Total 1 pages

8. On the Preview screen,

e Start: If the scanned image is OK, press the [Start] button () on

the touch panel to distribute the scanned image.

e Remove: If the scanned image is not satisfactory, tap the [Remove]

) to delete the scanned image.

e Insert: You may also insert more pages by taping the [Insert]

) button.

e Cancel: If the scanned image is not OK, tap the [Cancel] button

() to abort the job.

9. In a second, the scanned image will be sent to your E-mail addresses.
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Advanced Operation

Using Special Settings

Place your single-page document with text facing down on the document
glass or load your multi-page your document in the document feeder with
text facing down and the 1% page on the top of your document stack.

PN
Press the E-mail button on the Home screen. The following
E-mail main screen appears.

E_mail 2016/11/16 09:06

- -

. E-mail Advanced Layout Bind i = P~
() — m ﬁ
el |

Cloud R}

Cc ‘ 0 éé};

N

- Bcc ‘
= 2
Eaaait Document Sides Output Color

AT f 1-Sided Face J [m J

I_Er| " Do > Color >

[la¢ | Subject File Format

- [Please enter email subject ] [@ MPDF )J

Resolution
( 200dpi >]

Enter your E-mail address.

- Touch any place on the “"To” field (the empty box in the center) to bring
up the “Soft Keyboard” to type your email address. Press Enter to type
the 2" E-mail address and then click Return to return to the E-mail main
screen.

Enter or select CC and BCC address as well, if necessary. Enter the subject
of your E-mail via the soft keyboard. If not, the “"Default Subject” will be
displayed in recipients’ E-mail message.

On the Basic screen, check if the document sides, output color, or file
format meets your requirements. If not, change the settings to suit your
needs.

Tap the E-mail Options tab to prompt the E-mail Options screen. Type
your E-mail message if necessary in the Message field via the soft
keyboard, enter the attachment name of the scanned document, and the
“"Reply to"” address if necessary. (For more information about the settings,
see the settings description in the next two pages.)

Tap the Advanced Settings tab to prompt the Advanced Settings screen.
Change the density, contract, quality level, and resolution if the default
settings are not satisfactory. (For more information about the settings, see
the settings description in the next two pages.)
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10.

11.

12,

Tap the Layout Adjustment tab to prompt the Layout Adjustment
screen. Change original size, and preview if the default settings are not
satisfactory. (For more information about the settings, see the settings
description in the next page.)

Press the [Start] button to start a scan.

The product starts scanning and the preview image will be displayed.

On the Preview screen,

° Start: If the scanned image is OK, press the [Start] button
() on the touch panel to distribute the scanned image.
° Remove: If the scanned image is not satisfactory, tap the [Remove]

) button.

° Cancel: If the scanned image is not OK, tap the [Cancel] button

() to abort the job.

In a second, the scanned image will be sent to your E-mail addresses.

36



Settings Descriptions

Basic

Item

Description

Document
Sides

Choice: *1-Sided Face Down, 1-Sided Face Up, 2-Sided
1-Sided Face Down: Choose to scan single side of your
document and make sure the scanning side faces down on the
document feeder.

1-Sided Face Up: Choose to scan single side of your
document and make sure the scanning side faces up on the
document feeder.

2-Sided: If your original is a double-sided document, choose
2-Sided to scan both sides of your document.

Subject

Enter text for your email subject. Up to 64 characters are
allowed.

Resolution

The resolution is measured in pixels per inch (ppi) (sometimes
referred to as dots per inch or dpi). Higher resolutions result
in more detail in the scan, slower scanning and in general,
greater file sizes. When OCR (Optical Character Recognition)
is to be performed on a scan, 300dpi should be used for most
languages except Asian languages. For Asian languages, 400
dpi is recommended.

Resolution: 150 dpi Resolution: 200 dpi

Note: If you are scanning duplex (two-sided) paper in color
mode, the max. resolution is 400 dpi.

Choice: 100 dpi, 150 dpi, *200 dpi, 300 dpi, 400 dpi,
600 dpi.

Output
Color

Choose your desired output color for your scanned image.
Choice: *Color, Gray, B&W

Color: Choose Color if you wish to scan a color image for

your original in color.

Gray: Choose Gray image if your original contains actual
shades of gray.

Choose B&W if your original contains only text, pencil or ink
sketch.
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File Format

Choose the file format for your scanned image.

Choice: JPEG, TIFF (One-Page TIFF), M-TIFF
(Multi-Page TIFF), PDF (One-Page PDF), *M-PDF
(Multi-Page PDF), Searchable PDF, PDF/A(M-PDF), PNG

Note:

M-PDF or M-TIFF file format allows you to scan
multi-page document and convert it to a single file.
PDF file format allows you to save one image page in a
single file.

JPEG/PNG file format is available for Color and Gray
images only.

TIFF file format is available for B&W images only.

* Factory Default
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E-mail Options

Item

Description

From

Enter the "From” address of your outgoing mails from the
product. If an E-mail can not be sent, notification is returned
to this address. If the administrator has not set the device’s
email account in the Mail Server settings, you can enter the
email address here. This is the "From” address in your
E-mail when you receive an email from the product.

Reply To

Enter a "Reply to” address if you wish to specify a reply
address which is different from the “From” address. Up to 60
characters can be entered in the field. To enter the address,
you may press anywhere on the “Reply To” field to bring up
the soft keyboard to type the address.

Message

Type your email message here. To enter the text, you may
press anywhere on the "Message” field to bring up the soft
keyboard to type the text.

File Name

Enter the file name for your scanned document without
extension. If you have not entered a value in the box, the
system will bring you a default file name, image. Using #n
#Y#M#D#h#m+#s makes file name change as time goes. (n,
Y, M, D, h, m, and s represent series number, year, month,
date, hour, minute, and second respectively.) For example,
type file name: test#n#D will bring your filing file name as
test000105

File
Separation

Limit the file size of the attachment of each outgoing email to
avoid the size limitation from SMTP servers. Use the combo
box to select from the list.

Choice: 5MB/10M/20M/30MB/*Unlimited

* Factory Default
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Advanced Settings

Item Description
Density 7 levels of density are provided to adjust the lightness or
contrast of your document. If your original document is too light
or too dark, you can use this setting to adjust the scanned
image. Choice: Level -3~3. Default value: 0
Contrast
Contrast: -3 Contrast: 0 Contrast: 3
(Normal)
Choice: Level -3~3. Default value: 0
Adjust the Contrast slider right or left to increase or decrease
the contrast.
Remove If you wish to remove the blank page, you can adjust the
Blank Page sensitivity value to define the threshold. The higher the value,

the more the sensitivity.

Quality/File
Size

The options will be available only when “JPEG” format is
selected in the Attachment Format option. Choose the quality
level of your scanned image. The higher the quality, the larger
file size.

Choice: *Normal Quality/Small File, Higher
Quality/Larger File, Highest Quality/Largest File

Document Choose your document type.
Type Choice: *Mixed, Photo, Text
Text: Suitable for document contains pure text.
Photo: Suitable for document contains photos.
Mixed: Suitable for common business document with photo or
text.
Multi-Feed Choose if you wish to enable the Multi-Feed Detection via
Detection ultrasonic unit. Ultrasonic Detection allows you to set
overlapped document by detecting paper thickness between
documents. Choice: On/ *Off
Highlight Used to adjust the brightness of the entire image. The smaller

the number, the higher the brightness. Range: 128~*255

* Factory Default
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Layout Adjustments

Item

Description

Original Size

Press to select scan area.

e Auto: Let the machine automatically detect the scan area
according to your original.
Detectable size: A4, A5, A6, B5. LGL, LTR

e Preset Scan Area: Specify your scan area from a list of A4,
A5, B5, LTR (Letter), and LGL (Legal).

Choice: *Auto/Preset Scan Area

Auto
Orientation

When Auto Orientation is turn On, images can be rotated to
their proper orientations based on their contents. (*: off)

Preview

Turn on to display preview image in a low resolution to check if
the scanned image is correct.

Choice: *ON, OFF

Carrier Sheet
Mode

Check this option to automatically crop the scan window
according to your document size when scanning non-standard
document (fragile, irregular-size document) with a carrier sheet
(optional). On how to use the carrier sheet, plese refer to the
subsequent section on page 118.

* Factory Default
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Setttings for Various Mail Servers

When using the Scan-to-Email function, the machine will encounter various

setting problems on mail servers and cause the mails to be sent

unsuccessfully. This document is intended to help users to solve the settings

problems. The following is the setting information for Gmail and Office365.

For Gmail

1.

Setting on a Gmail Account

When using Gmail as Mail Server, due to security issues, you will be
denied when you log in, and an error code 531534 will be displayed on
the machine. There are two ways to solve it. One is to access less

security app. The other is to enable 2-Step verification to generate a
set of app password for the machine.

(1) Access less security app.

Please first apply a testing account - testxxx@gmail.com and a
password — pwdxxx to specify the following settings:

(@) Login Gmail mailbox, enter My Account and then select [Security] and
cIick [Off] from the [Less secure app access] option.

o = @

- M
= ‘ : ]
(b) Turn on [Allow less secure apps: ON] as indicated.
Google Account = @

< Less secure app access

Then, the machine can directly use the longin password on Gmail server.
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(2) Enable 2-Step verification to generate App Password for the

machine.
Turn on 2-Step verification:
(a) Click [My Account]>[Sign-in & security]>[Password & sign-in
method] in succession and then turn on [2-Step verification] as

indicated in below.

P b ootz %Y G Sgonmecuny % (G Sgnindsenny % 8 The GG Ubeancre: %\, al=l@l ]
. ]
Welcoma b aven

Personal infa & privacy
Pazsward

About Bacgle

(b) Click [GET STARTED] when the following dialog box is prompted.
eG:g:: i o - .;

-
-
- Even'f aome coe getsyout passwond, 1t wertbe
GeT stasTen

Enter your password and click [Next] when the new login screen is

(c)
prompted.
« C & accountsgooghecom N2 challonge/pwdcontinue=hipssIARF¥% ZF myaccount. google O tlonsSk2Ftwo-step-verificati mani. o @
Google
Hi Bavalia
@ bavaliabudapestBomail.com v
(d) Enter your mobile phone number and then click [TRY IT] to get the

verification code.
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(e) Check the text message of your mobile phone and then enter the
verification code in the following dialog box and click [Next].
/¥ o etttz %Y 5 PG (% D= 18/ lol@l = |

€ — €[ 8 =2 | hips/myaccount google.convsecurtysigninoplions/tw-stes-ver fcation/enrolrapt - AEJHLACVIN XHGHIK 5

gLSDL-0ATSHIMAFGSA-30yqdyZXSLc_eZbaL1VIQIQSEd_Kyy

Google LN .}
& 2-Step Verification 2]
Confirm that it works
th 8 verdication cods ta 0928902 249
Back Step20f3 X
Googe TemaLPrbacy i

(f) Click [TURN ON] to complete the 2-Step verification.

4 b (13)-jesseSii. G 2-5rep Venfcanon ! [ Somndseary  x {8 TheGMUCUbeany e 3\

€ @ & =2 | hupsy/mysccountgonglecomsecurity/signing

srvenrallTrapt - AETHLADWNIxHGHIK_BCnglS0t-DAtaNmAFgSA-30yqdyZX5 Ue_eZbdL 1Y IQ5Ed_Ky Qo

Google

It worked! Turn on 2-Step Verification?

Step3af3 TURNON
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Generate App Password:

(a) Return to [Signing in to Google] screen, an additional item - [APP
passwords] will be added on the [Password & sign-in method] option as
indicated in below. Click [>] as shown in the red box.

M Tabee 18- oS8 X

S SgnmBuecinty X\ € The G Clbrary Re X
pa

sil=i@ o |

Signing in to Google

Make sure you choose & strong password

screen.

a)lsl@) s

(b) Choose [Other (custom name)] in the following

M b 35 e x Savntary % | oG i

€ o C |8 =8| sl

- Ik
Google z 0@

(c) On the output device — MyScanner, click [GENERATE].
‘G:gl‘a%. . # 0 ; .

Voubuave m9 309 passwords.

(d) The white text on the blue background is your app password for the

device. Make sure to copy the password first and then click [DONE].
Enter this password on the machine’s mail server setting.
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T oy p— oy prep (Lo sllslml =)

L3 C | & =8 | https./security google.com/settings/security/apppassiwards LR}

Generated app password

| WebManagerss

Network >> Email Server I

Information

Device Management

Email Server

Network
Email Server: [smtp.gmail.com |
Email Server SMTP Port=: [465 |
LDAP Server Authentication Method: | [on v
e Encrypt: [ssL v]
Security Setup Login Name: av01935@gmail.com J
Email Default Password: |m J |

Filing Default
Filing Profiles
Address Book

Shortcut

Setttings on the Machine’s Webpage

(a) Open your browser and type the machine’s IP address on the URL
address to open the device’s enbedded webpage.

(b) Choose [Network] to open the [Network Settings] page and enter
Gmail's account and password. Be sure to add @gmail.com after the
account and choose a encryption type, for example, SSL.

“bbs\!an{{gor o

Network Settings Update l

Information

Wired Mail
|
E-mail Default
= Mail Server: 64.233.187.108

Filing Default

SMTP Port=: 465
Filing Folder Fenbcation

ati

Address Book Method: N -
Shorteut e SSI 2
Public Folder Login Name: av01935@gmail.com

Password: f ---------

Note:

Gmail supports non-encryption connection yet you can only send mail to Gmail
users. The setting is:

Mail Server: aspmx.l.google.com

SMTP Port#: 25

Authentication Method:off

Refer to https://support.google.com/a/answer/176600?hl=zh-Hant
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For Office365

Check if Connection Line is OK

To use office365, you must go through an external line and make sure
connection is OK. The following is how to check if the connection is OK.

Take Optionl mail server as an example:

B HEEEE C\Windows\system32\cmd.exe

Microsoft Windows LRF
Copyright <c?> 2807 Microsoft Corporation. All rights reserved.

C:sUlsers~avB1B867>telnet smtp.office3dbb.com 587

If successful, the following screen will be prompted.

BN Telnet smip.office365.com |ilglﬂ—hj

2208 SIXPRAGCABO2S .outlook.office365.com Microsoft ESMIP MAIL Service ready at Uelld
d. 18 May 2016 B1:34:85 +AE00

The following link is a link to Office365. It contains informations for various
options. This document will explain Option1, Option2 and Office365 mailbox.

https://technet.microsoft.com/en-us/library/dn554323(v=exchg.150).aspx#option2

(a) Option1

1. This option can send mail to outside mailboxes such as Gmail or yahoo. This

method requires account and password login. The settings are:
Authentication: ON

Encrypt: STARTTLS

Port: 587

Mail Server: smtp.office365.com

Login Name : Network@tw.avision-global.com

Password : refer to Office365Pwd.txt

WebManager,

Network Settings Update
Wired Mail

Mail Server: smtp.office365.com

SMTP Port#: 587

Authentication =

Method: N

Encrypt: TLS/STARTTLS v

Login Name: Network@tw.avision-global.com

Password: ~ [esssesese

After completing the above setting, be sure to fill in the [From] field with

your Office365 account. On the machine’s touch panel, tap [E-mail]>[E-mail
Options] and then enter Office365 account in the [From] field as shown in

below.
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Avision 2020/6/18 17:00 IP 10.1.22.38

__ | s = - 8 ° e A
File Name
6 Shortcut S;ggs
File Separation
( Unlimited )
b WA@
E-mail <>
L Evara Scan
£ - Network@tw.avision-global.com E
s - Ciline
AN360 series AN335 series

(b) Option2

This option can only send mail to office365 accounts that are also registered
in the same group, and cannot sent mail to outside mailboxes. This method
does not require account and password. Settings are as follows:

Authentication: OFF

Encrypt: None

Port: 25

Mail Server: contoso-com.mail.protection.outlook.com

The following screen shows the Office365 mail server applied by Avision)
(The Avision office365 mail server account:
tw-avisionglobal-com02e.mail.protection.outlook.com)

WebManagers

Network Settings | Update ]
Information
General
== Wired Mail
Network
E-mail Default
= Mail Server: tw-avisionglobal-com.mail.protection.outlo
Filing Default
SMTP Port=: 25
Filing Folder Vi 8
— Authentication OFF =
Address Book Method:
Shortcut Encrypt: None v
Public Folder Login Name:
Password:

(c) Office365 Mail Box
Slmply click [Mall] after login to Office365 as indicated in below.

Vrebians: %7 7

« % Y G Signin- Google Accour

Good morning, team

-]

Use the online apps

DopoEoooD
oon

Get Office on all of your devices
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How to import e-mail address from a LDAP Server

1. Configuring Your LDAP Server Setting:

(1). Open your browser and type the IP address of the device on the URL
address. The webpage of the device appears.

(2). Login the webpage. (default user name and password: admin)

(3). Choose [Network]>[LDAP Server]>[Authentication LDAP] in
succession.

(4). Enter your LDAP information respectively and then click [Update] to
complete. Refer to the following example.

Search Name from: |

Network >> LDAP Server Update ‘
Email LDAP Authentication LDAP
LDAP Server IP or URL: [10.1.90.21 |
Ports: 339 \
Login Name: [av01935 |
Password: | ‘
Search Root(Base DN): |dc:awsmﬂ dc=com,dc=tw \
Search attribute: [en |
Obtain email address from: [mail |

Get Account Name From: |sAF-:IAccountName

Ex:sAMAccountName
Timeout[seconds]: |5

Domain 1: |aV\5|onhq

Domain 2: |

Domain 4: |

|
\
\
Domain 3: | ‘
\
|

Domain 5: |

Authentication Type: [SIMPLE v

Authentication LDAP Test

Select Domain: [Domain 1 ~ | Test

(5). You may try [Authentication LDAP test] to check if the connection
and login test successful with admin's AD(ActiveDirectory) account.

2. Set Accounts with LDAP authentication:

(1). On the device’s webpage, choose [Account Management] and
check [Enable Security Management] & [Enable LDAP
Authentication].

Basic Account List

Enable Security Management [] Enable Guest Account Enable LDAP Authentication

Shortcut Cloud Email Filing

Default Enable Function
’7 BM2 Air Scancast AP Mode

(2). Click the [Account List] tab, and click [New]. Check [LDAP
Authentication].

(3). Click [LDAP Search] and then enter your account and click [Submit]
to search your AD account. The search result will be displayed as
illustrated.
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Account Management >> New

| submit | Quit

LDAP Authentication
User Name:

Password:

Email Address:

| LDAP Search |

Enable Function

) Shertcut [ Cloud [ Email [ Filing
) BM2 Air [J Scancast [J AP Mode
LDAP Subi |
—
9 User [ Group | 4 pomain [Domaint (avisionha) »| [Av01935 | search ||
CN Name Email Address
FiRE AVD1935 mark_wang@avision.com.tw

[ avois3s-pC AV01935-PC$

mark_wang@avision.com.tw

[[] Av01835-20532 AW01935-20532...

mark_wang@avision.com.tw

AV01935-
O 20532...

AV01935-20532...

mark_wang@avision.com.tw

] Av01935-40675 AV01935-40675...

mark_wang@avision.com.tw

Page1(1/1)

3. Use your account to log-in your network scanner.

Account Management >> New

Quit

|| Submit ||
— 1

LDAP Authentication
User Name:

Password:

Email Address:

avisionhq\Av01935

LDAP Search

mark_wang@avision.com.tw

Enable Function
Shortcut
BM2 Air

Cloud
[J Scancast

Email Filing

AP Mode

Account Management

\ Basic \ \ Account List
Action:| New | Delete | Modify |
Account Email Address

[J avisionhg\Av01935

mark_wang@avision.com.tw

[Page 1 (1/1)
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To import email address from LDAP Mail Server:

(1). Open your browser and type the IP address of the device on the
URL address. The webpage of the device appears.

(2). Login the webpage. (default user name and password: admin)

(3). Choose [Network]>[LDAP Server]>[Email LDAP] in succession.

(4). Enter your settings and click [Submit] to complete. Refer to the
following example.

QObtain email address from: |ma\|

LDAP Setting >> Modify [ submit | Qut | |
Name: | Avisioniviail |
LDAP Server IP or URL: |1D.1 90.21 |
Port#: [389 |
Login Name: [avD1935 |
Password: [sreene |
Search Root(Base DN): |dc=avision‘dc=c0m,dc=lw |
Search attribute: |cn |
|
Search Name from: [sAMAccountName |

Timeout[seconds]: [5 |

Authentication Type: [SIMPLE v

(5). Then set a Mail LDAP.

Network >> LDAP Server

Email LDAP Authentication LDAP
Action:] New | Delete | Modify |
LDAP name IP/URL
[ avisionMail 10.1.90.21

(6). Choose [Address Book]>[External Address Book] in succession.
(7). Choose the Mail LDAP you have set.

Address Book ‘

Email List Group List External Address Book
Action:] New | Delete | Modify |
Name Email Address Description
] mMark av01935@gmail.com
1/2000 [Page 1 (1/1) |

(8). Search your account, and choose [Import to Email List].

b 10.1.20.109/Tframe.htm - Google Chrome E

A Notsecure | 10.1.20.108/Iframe.htm

LDAP |
Action: | | Import To Email List| |AvisionMail v Mark search ‘
Name Email Address
IiRE mark_wang@avision.com.tw

[Page 1(1/1) \

(9). Finally, refresh your device’s webpage, you will see your e-mail has
been added to the address book from the LDAP Mail server.
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Address Book

[ Email List

[ Group List

[ External Address Book

Action:| Mew

Modify |

Name
) Mark

Email Address

Description

av01935@gmail.com

mark_wang

mark_wang@avision.com.tw

2/2000

[Page 1(1/1) \
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Sending Your Document to a Network Folder, a USB
Flash Drive or a Public Folder

Important:

To send your scanned images to a network folder such as FTP, FTPS, FTPES,
SharePoint, or SMB, make sure you have the privilege to access the network
folders. For example you need to create a login name and password first.

Basic Operation
Using the Default Settings

1. Place your single-page document with text facing down on the document
glass or load your multi-page your document in the document feeder with

text facing down and the 1% page on the top of your document stack.

-
3. Press the Filing button on the Home screen. The following Filing

main screen will be displayed.

I 2020/1/31 09:30
Filing
A - -
. Advanced Layout Bind = 2
e Baste
‘ Scan to

Ko N ‘SharePoint Freq.
Cloud o -
FTP 1

e
= L)
E-mail Document Sides Output Color
- > . F.Down | > [[] B&W )]
'Il] File Name File Format
4
[ 566 i adbinidelh ] fE  Multi-pagepor |3

Resolution
il

4. Choose a [Scan to] destination to store your scanned image.

- Choose Network or Local.

- If Network is selected, the available network servers will be displayed
at the right box. You may use the Up-arrow or Down-arrow button
to scroll from the list.

- If Local is selected, USB and Public Folder will be displayed at the
right box. If USB is selected, make sure a USB flash drive has been
inserted to the USB flash drive port of the product.

If Public Folder is selected, the scanned image will be stored in the
product’s memory. Enter PIN number (folder name) during scanning
and then access the scanned image via the product’'s embedded web
page. (Refer more detailed information on subsequent section -
Customizing the Product’s Settings via the Embedded Web Page.)
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5. 1If desired, enter the file name prefix in the [File Name] field for the
scanned document.

6. Check if the document side, output color, or file format meets your
requirements. If not, change the settings to suit your needs.

7. Tap the [Start] () button. The scanner starts scanning your

document.

The product starts scanning and the preview image will be displayed.

On the Preview screen,

Start: If the scanned image is OK, press the [Start] button ()

on the touch panel to distribute the scanned image.

Remove: If the scanned image is not satisfactory, tap the [Remove]

) button.

Cancel: If the scanned image is not OK, tap the [Cancel] button

() to abort the job.

10. In a second, the scanned image will be sent to your email addresses.
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Advanced Operation

Using Special Settings

1. Place your single-page document with text facing down on the document
glass or load your multi-page your document in the document feeder with

text facing down and the 1% page on the top of your document stack.

)

r
2. Press the Filing B button on the Home screen. The LCD Touch Panel

prompts the following Filing main screen.

F||Ing 2020/1/31 09:30

w— R -
q Advanced Layout Bind = 2
— =1
‘ Scanto
‘ SharePoint
el
FTP 1
—
-~
'< Q »)
Za .
E-mail Document Sides Output Color
|1> F.Down | > [D B&W )]
[las | File Name File Format
E 7] — | [ wutipageror 3]
Filing S
(.

3. Choose your [Scan to] destination to store your scanned image.
- Choose Network or Local.

- If Network is selected, the available network servers will be displayed
at the right box. You may use the Up-arrow or Down-arrow button
to scroll from the list.

- If Local is selected, USB and Public Folder will be displayed at the
right box. If USB is selected, make sure a USB flash drive has been
inserted to the USB flash drive port of the product.

If Public Folder is selected, the scanned image will be stored in the
product’s memory. Enter PIN number (folder name) during scanning
and then access the scanned image via the product’s embedded web
page. (Refer more detailed information on subsequent section -
Customizing the Product’s Settings via the Embedded Web Page.)

4. On the Basic screen, enter your desired file name and check if document
side, output color, or file format meets your requirements. If not, change
the settings to suit your needs.

5. Tap the Advanced Settings tab to prompt the Advanced Settings
screen. Change the density, contract, resolution, and quality level if the
default settings are not satisfactory. (For more information about the
settings, see the settings description described in the preceding section -
Scanning and Sending Your Documents to E-mail Addresses on page 31.)
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6.

Tap the Layout Adjustment tab to prompt the Layout Adjustment
screen. Change original size and preview if the default settings are not
satisfactory. (For more information about the settings, see the settings

description described in the preceding section - Scanning and Sending Your

Documents to E-mail Addresses on page 30.)

7. Tap the Start button. The scanner starts scanning your document.

8.

9.

10.

The product starts scanning and the preview image will be displayed.

A
Remove

T Total 1 pages

On the Preview screen,

Start: If the scanned image is OK, press the [Start] button ()

on the touch panel to distribute the scanned image.

Remove: If the scanned image is not satisfactory, tap the [Remove]

) to delete the scanned image.

Insert: You may also insert more pages by taping the [Insert]

) button on the bottom of the screen.

Cancel: If the scanned image is not OK, tap the [Cancel] button

() to abort the job.

In a second, the scanned image will be sent to your specified network
folder.
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How to Send Your Image to SharePoint

SharePoint (Server) is a web-based platform that your company owns and
operates. You can use the web site as a secure place to store, organize, share
information from any device through a web browser.

To add a SharePoint server for your filing profile,

1. Open your browser and type and IP address of your scanner. An embedded

webpage appears.

2. Login the page to acess more settings with default user name and
password — admin.

3. Click [Filing Profile] and then [New] to create a new filing profile.

Filing Frnfilesg |

— " by ”
N Action: \;New | Qelete | Modify |
......
Profile Name

Email Default

[ ciFs

O FrP

[ PublicFolder
[ FTP2
/50

[Page 1(1/1)

Impo

Product Key Setting

4, Enter your Profile Name. For example, SharePoint.

5. Select [SharePoint] from the [Target URL] field and then type the IP
address or domain name of the SharePoint server provided by the IT
department of your company as illustrated in below:

o —

Filing Profiles Editor Test ‘
Inf
D.

Profile Name: SharePaint ]
=
En —— Advanced Layout

Setting Adjustment

............................

Terget urL:

.

.
fort:
Bomain:

[abecom

fogin name: dresden234
Bassword:
file Name: [sP_#n

" ExiDOC_#Y#M=Dsh&m=s#n .
AEmspapsssssssnnn EEEEEEEEEEEEEEEEEEEEEEEEEEEEER

Document Sides: 1-Sided Face Up ~
File Format: TIFF (One-page TIFF) ~
<
~

Color Mode: BW

Resolution: 300dpi

You may also check with your IT personnel for the server port, domain
name and make sure that you have an authorized account.

6. Enter your login name and password.

7. Click [Submit] to complete the SharePoint settings.

If successful, a [SharePoint] profile will appear on the Profile list as shown

in below.
Filing Profiles ‘
Action:| MNew | Delete | Modify |
Profile Name
[ cIFs
[ FTP
"EF PEBIRFAZS" """
[ SharePoint H
Y LLLLELELIL - ‘Pageﬂ A1)
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To scan and send your image to SharePoint Server,

1. For AN335W/AN360W series, tap [Filing] and then choose [Network]
from the [Scan to] option. Finally, choose [SharePoint].

For AN335WL series, tap [Filing] and then choose [SharePoint].

Avision 2020/6/18 17:01 IP 10.1.22.38

ey . ‘ Scanto [ magmssssssssssssssss
N HE i Y
: A PR FIP 1 :
E FTP1 E SharePoint )A'{ JI: ................ =¥ »
. . E_?ai, Document Sides Output Color
— Messssnssnns = (dE rom B M BaW 5)
- File Name File Format
usB 'Q' :I- [Ewncwwmmmw ] @ Multi-page PDF >]
Settings L Resolution
e
AN335L series AN335W/AN360W series

2. Load your document to the scanner and then tap the [Start]
button.

3. In a second, the scanned image will be sent to the SharePoint server.
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Sending Your Document to Clouds

Basic Operation

Important:

To send your scanned images to a cloud server such as Google Drive, Evernote,
OneDrive, and SharePoint Online, make sure you have the privilege to access the
cloud servers. For example you need to create a login name and password first.

Using the Default Settings

1. Place your single-page document with text facing down on the document
glass or load your multi-page your document in the document feeder with

text facing down and the 1% page on the top of your document stack.

F
2. Press the Cloud button on the Home screen. The LCD Touch Panel

prompts the following Cloud main screen.
Cloud 2020/1/16 10:40

A @R 6

. Advanced Layout Bind i S

() Baste
‘ ‘ GoogleDrive 1

OneDrive 5
(P —
P SharePointOnline
2 2
Esmail Document Sides Output Color
—— | ("B, rom B [ B&W >)
[lo¢ | File Name File Format
- LEX’DDC}'Y!M:Dﬁhﬂm:sxn J @ Multi-page PDF >]

Resolution
s

3. Choose your desired cloud server to save your scanned images. Choice:

Evernote, Google Drive, SharePointOnline, OneDrive.

4. Check if the document side, output color, or file format meets your

requirements. If not, change the settings to suit your needs.

For SharePointOnline, you may enter your desired site name to store your

scanned image. Otherwise, the image will be sent to a default site name.

5. Tap the Start button. The scanner starts scanning and a Preview

screen will be prompted.
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il Total 1 pages

6. On the Preview screen,

° Start: If the scanned image is OK, press the [Start] button

() on the touch panel to distribute the scanned image.

° Remove: If the scanned image is not satisfactory, tap the [Remove]

° Cancel: If the scanned image is not OK, tap the [Cancel] button

() to abort the job.

7. The product begins to upload your scanned images to your specified cloud

server.

On the web site of your specified cloud server, you will be required to
complete the login and authorization. If successful, your account will be

displayed and the scanned image will be stored in the cloud server.
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Advanced Operation

Using Special Settings

1. Place your single-page document with text facing down on the document
glass or load your multi-page your document in the document feeder with

text facing down and the 1% page on the top of your document stack.

&
2. Press the Cloud button on the Home screen. The LCD Touch Panel

prompts the following Cloud main screen.

2020/1/16 10:40
Cloud
EN - -
: Advanced Layout Bind ] 5o AL
/AR—— paste .b ﬁ
‘ ‘ GoogleDrive ‘

OneDrive 5
SharePointOnline
N
Document Sides Output Color
t% > ~ F.Down >] [D B&W )]
File Name » File Format

Ex:DOC_#Y#M#D#h#més#n ] @ Multi-page PDF )]
Resolution
- [ 200dpi >]

3. Choose your desired [Scan to] cloud server to save your scanned images.
Choice: Evernote, Google Drive, SharePointOnline, OneDrive.

4. On the Basic screen, check if the document sides, output color, or file
name meets your requirements. If not, change the settings to suit your
needs.

5. Tap the Advanced Settings tab to prompt the Advanced Settings screen.
Change the density, sharpness, contract, saturation, and quality level and
select resolution of the scanned image if the default settings are not
satisfactory. (For more information about the scan settings, please refer to
the preceding section - Scanning and Sending Your Documents to E-mail
Addresses on page 31.)

6. Tap the Layout Adjustment tab to prompt the Layout Adjustment
screen. Change original size and original orientation if the default settings
are not satisfactory. (For more information about the scan settings, please

refer to the preceding section — Scanning and Sending Your Documents to
E-mail Addresses on page 33.)

7. Tap the Start button. The scanner starts scanning your document.
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8.

mn Total 1 pages

On the Preview screen,

e  Start: If the scanned image is OK, press the [Start] button ()

on the touch panel to distribute the scanned image.

° Remove: If the scanned image is not satisfactory, tap the [Remove]

° Cancel: If the scanned image is not OK, tap the [Cancel] button

() to abort the job.

The product begins to upload the scanned images to your specified cloud
server.

On the web site of your specified cloud server, you will be required to
complete the login and authorization. If successful, your account will be
displayed and the scanned image will be stored in the cloud server.
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How to Send Your Image to SharePointOnline

SharePoint Online, a platform within Microsoft Office 365, is a cloud-based

service provided directly by Microsoft.

To set SharePointOnline Setting:

1. Open your browser and type and IP address of your scanner. An embedded
webpage appears.

2. Login the page to acess more settings with default user name and
password — admin.

3. Click [ShortCut]>[New]>[Cloud] in succession to create a new ShorCut to
speed up the process.

Web) ir

(3)

H .
Action: B New | EDelete | _J%diad aOrder |

¥R ST " Filng s Cioud | &

Shortcut Name = Shortcut Type
[J 1 usB Flash uss
[J 2 Public Folder HD
[] 3 Joanne_SP Filing
3/24 < | <<[Page 1(1/1) | >>] >

Product Key Setting

—
4. Enter your Shortcut Name. For example, ShortPointOnline.

5. Select [SharePointOnline] from the [Target URL] field.

6. Enter your subfolder name to store the image. For example, bess. (You can
create next subfolder by adding “/”, for example, bess/invoice.

7. Enter your site address (group name). For example, 789. Or using default
site address to be stored in [Group website] site.

Shortcut >> Cloud Submit Quit ‘

Shortcut Name: ]

z Advanced Layout
=R Setting Adjustr

Target URL: [SharePointOnline ~]

File Name: [DoC_shemestn
Ex:DOC_sv=M=D=hsm=s=n

passive Mode:

<<

Document Sides: 1-Sided Face Down
File Format:
Color Mode: [Gay ]
AP s s s nnnn 2% %ennnnnnsnnnnsnnnnnnnnihnn,
= Subfolder Name: bess
)

u Site Address: 789
EsssssEsEEEEEEEEEEEEEEEEEEEEEEEEEESEEEEEEEEEEEEER

8. Click [Submit] to complete the settings.

9. If succesful, a new SharePointOnline will be added to the list as indicated in
below.

Shortcut

Action:| Mew | Delete | Modify | Order |

Shortcut Neme Shortcut Type
[0 1 ussFash use
(] 2 Public Folder HD
- hEn anFingennn
0« Cloud

.
LT ETT

CisaE i iV nunnn
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To scan and send the image to SharePointOnline:

Load your document to the scanner.

On the touch panel, tap the [Start] button of the [SharePoint] shortcut.

Avision 2020/6/18 16:56 IP 10.1.22.38 = F - Avision
[ = —
Shortcut z:u
B&W/200dpi Color/300dpi Color/300
1-Sided FaceD: 2-Sided 1-Sided F: &
w‘@ M:Jla-paagceeP;:n J:’G Mullti-epag:( ﬂl « »
E-mail PLLLLCLLLLLEr . 0] Salor
H . Multi-page PDF
a Ol O O
s | 5 7 LT )
AN335L series AN335W/AN360W series
3. When the following [Sign in] dialog box is prompted, type your account name,
password, and then click [Next]. Click [Yes] when [Stay sign in] dialog box
is prompted.

2% Microsoft =. Microsoft

Sign in & dresden@abc.com

dresden@abc.com Enter password

NosmauntCeeonel e J

Sign-in options Forgot my password

>
. The scanned image will be delivered to your SharePointOnline Cloud.
5.

Folloning

Open your browser and type the IP address/domain name of your company’s
SharePointOnline server. You can find your image in the SharePointOnline
page as shown in below. (Group name: 789, Subfolder: bess)

TLLLL -
Frequently used websites s =

64

activity

Use "News” on the group website
o keep group members updated &

Your
Subfolder

File Name



Creating a Shortcut Button

By setting frequently used scan settings and destinations as Shortcut on the
Home screen, the product helps you to streamline your workflow and complete

your scanning task in just one single step.

Plus, if the cloud server has been setup as a shortcut button on the main screen,
the login name and password will be remembered to save you the trouble of
having to enter the information each time you access the cloud server.

To create a Shortcut button,

1. Select your frequently operational mode on the left panel. For example,
E-mail. The E-mail screen will be displayed on the right panel.

2016/11/16 09:06

1P-101.2063 Nov 9, 2015 10:43:21 AM -
E-mail
2 i
- -
. E-mail Advanced Layout Bind = 3
__ [~ EkaEa - 80
23 To
Cloud ¥ N
G
Public Folder ﬁ Bec| )
Gl b2 v Document Sides Output Color
olor q
300dpi —— | (v [E] Siedrace >] [i] Color ’)
M-POF ' [ | Subject File Format
Please enter email subject @5 MPDF >
@ Filing z
Resolution
J 200dpi >
_ —

2. Select your frequently used E-mail address in the [To]/[CC]/[BCC] field.

E-mail 2016/11/16 09:06
- T

i -mai in ] 2%
e ] O3 AddaNew
‘ (1o ShortCut

Button

: Cc ’ 0
)
P Bce |
pad 2
E-mail Document Sides Output Color
—_— ‘/ilerJ "» E 1'8'32::3“ >J @ Color ﬂ
flos | Subject File Format
- [P[ease enter email subject } H_&‘; MPDF >]

Filing N
Resolution
[ 200dpi >]

On the [E-mail options] screen, type your [From] address.

4. Check if any of the scan settings needs to be changed to suit your

frequently used E-mail task.
-
5. If the scan settings are satisfactory, tap the [New ShortCut] — to

create your new ShortCut.
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6. An [Enter a Shortcut Name] dialog box will be prompted.

Save current settings as a new shortcut

Please enter a shortcut name:

Cancel 0K

7. Enter your shortcut name and tap [OK]. For example, bess. The new
shortcut button will be displayed on the LCD Touch Panel.

L 1P:10.1.21.208 2017/11/2710:19
Avision
_ .E

/S—

[ —

T USB Flash The New
el P »|  ShortCut
Email Color Color Color Name

D 200dpi 200dpi 300dpi
s | Multi-page PDF Multi-page PDF JPEG
Filing b ‘

=

Note:
Follow the similar procedure to create your frequently Cloud or Filing destination
to be your ShortCut on the LCD Touch Panel.
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Using the Shortcut Buttons

To use a Shortcut button,

1. Tap the [Start] button of your desired ShortCut button on the touch screen.

Avision

USB Flash

Color
200dpi
Multi-page PDF

1P:10.1.21.208

N
Public Fo...

Color
200dpi
Multi-page PDF

1

2017/11/2710:19

=
—

300dpi
JPEG

2

The ShortCut
Button

)
»
Py
E-mail
/P —",
Filing

The Start Button

¢ ]

)|

2. The scanner starts scanning and a preview image will be displayed.

3. On the Preview screen,

L Remove

m Total 1 pages

e Start: If the scanned image is OK, press the [Start] button () on

the touch panel to distribute the scanned image.

e Remove: If the scanned image is not satisfactory, tap the [Remove]

button ( ) to delete the scanned image.

e Insert: You may also insert more pages by taping the [Insert]

) button.
e Cancel: If the scanned image is not OK, tap the [Cancel] button to
abort the job.

4. The scanned images are sent to your specified destination.
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Scanning and Broadcasting Your Images

The Scancast (Scan and broadcast) feature allows you to scan a document first
and then send to many destinations respectively.

Basic Operation

Using the Default Settings

1. Place your single-page document with text facing down on the document

glass or load your multi-page your document in the document feeder with

text facing down and the 1% page on the top of your document stack.

—,

o)
-

Scancast

2. Press the Scancast

Scancast main screen will be displayed.

Scancast 2015/12/04/ 03:31

Document Sides

5 Advanced Layout
fasie

Output Color

(B LD B

éu» . o B Color |>
File Name File Format
[Ex:DOC_#Y#M#D#h#m#s#n] [@ MPDF ‘)]

Resolution

200dpi >

-

L)

button on the touch screen. The following

3. If desired, enter the file name prefix in the [File Name] field for the

scanned document.

4. Check if the document side, output color, or file format meets your

requirements.

If not, change the settings to suit your needs.

5. Tap the [Start] () button. The scanner starts scanning your

document.

6. The product starts scanning and the preview image will be displayed.
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On the Preview screen,
° Start: If the scanned image is OK, press the [Start] button

() on the touch panel to distribute the scanned image.

e Remove: If the scanned image is not satisfactory, tap the [Remove]

) button.
° Cancel: If the scanned image is not OK, tap the [Cancel] button

() to abort the job.
If the [Start] () button has been selected, the [Scancast]

window for multiple destinations appears.

Scancast Dec4,2015 3:33:14 AN,

Cast To

C9 B3 E

Choose a [Cast To] destination for your scanned image. Choice: Cloud,
E-mail, Filing.

- Cloud: Choose your desired cloud servers from a selection of
Evernote, and Google Drive.
- E-mail: Enter [To/From] E-mail address.

- Filing: Choose your network folder from a selection of Local or
Network. If Network is selected, the available network servers will
be displayed at the right box. You may use the Up-arrow or
Down-arrow button to scroll from the list.

If Local is selected, USB and Public Folder will be displayed at the
right box. If USB is selected, make sure a USB flash drive has been
inserted to the USB flash drive port of the product.
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If Public Folder is selected, the scanned image will be stored in the
product’s memory. Enter PIN number (folder name) during scanning
and then access the scanned image via the product’'s embedded web
page. (Refer more detailed information on subsequent section -
Customizing the Product’s Settings via the Embedded Web Page.)

10. After your first destination has been specified, press the [Start] ()

button to send the scanned image to the destination.

11. After the scanned image has been delivered successfully to your first

destination, the [Scancast] window for multiple destinations appears
again.

Scancast

Cast To

CHE=

@

12. Repeat Step 9 to choose your 2" destination and then press the [Start]

() button to send the scanned image to the destination.

13. Repeat Step 12 ~ Step 13 to send the scanned image to another
destination.

14. If you have finished distributing your scanned image to all the destinations
you want, press the [Back] button to exit the screen.
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Advanced Operation

Using Special Settings

1.

Place your single-page document with text facing down on the document
glass or load your multi-page your document in the document feeder with

text facing down and the 1% page on the top of your document stack.

o]
~

Press the Scancast ®=I=E¥ button on the touch screen. The LCD Touch

Panel prompts the following Scancast main screen.

Scancast 2015/12/04/ 03:31

-
> Advanced Layout P
~a | "
‘ Document Sides Output Color
™| Cd-E 5 B |
||> Doun > Color ‘)
File Name File Format
N
’v‘ {Ex:DOC_#Y#M#D#h#m#s#n] [@ MPDF )]
p o~ : )
E-mail Resolution
—— 200dpi | >
e
Filing

On the Basic screen, enter your desired file name and check if document
side, output color, or file format meets your requirements. If not, change
the settings to suit your needs.

Tap the Advanced Settings tab to prompt the Advanced Settings screen.
Change the density, contract, resolution, and quality level if the default
settings are not satisfactory. (For more information about the scan settings,
please refer to the preceding section — Scanning and Sending Your
Documents to E-mail Addresses on page 31.)

Tap the Layout Adjustment tab to prompt the Layout Adjustment
screen. Change original size and preview if the default settings are not
satisfactory. (For more information about the scan settings, please refer to
the preceding section - Scanning and Sending Your Documents to E-mail
Addresses on page 33.)

Tap the Start button. The scanner starts scanning your document.

The product starts scanning and the preview image will be displayed.
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mn Total 1 pages

8. On the Preview screen,
° Start: If the scanned image is OK, press the [Start] button

() on the touch panel to distribute the scanned image.

e Remove: If the scanned image is not satisfactory, tap the [Remove]

° Insert: You may also insert more pages by taping the [Insert

Pages ( )] button on the bottom of the screen.

° Cancel: If the scanned image is not OK, tap the [Cancel] button

() to abort the job.
9. If the [Start] () button has been selected, the [Scancast]

window for multiple destinations appears.

Scancast

3 E3 E3

10. Choose a [Cast To] destination for your scanned image. Choice: Cloud,
E-mail, Filing.

- Cloud: Choose your desired cloud servers from a selection of
Evernote, and Google Drive.

- E-mail: Enter [To/From] E-mail address.

- Filing: Choose your network folder from a selection of Local or
Network. If Network is selected, the available network servers will
be displayed at the right box. You may use the Up-arrow or
Down-arrow button to scroll from the list.
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11.

12,

13.

14.

15.

If Local is selected, USB and Public Folder will be displayed at the
right box. If USB is selected, make sure a USB flash drive has been
inserted to the USB flash drive port of the product.

If Public Folder is selected, the scanned image will be stored in the
product’s memory. Enter PIN number (folder name) during scanning
and then access the scanned image via the product’'s embedded web
page. (Refer more detailed information on subsequent section -
Customizing the Product’s Settings via the Embedded Web Page.)

After your first destination has been specified, press the [Start]
() button to send the scanned image to the destination.

After the scanned image has been delivered successfully to your first
destination, the [Scancast] window for multiple destinations appears
again.

Scancast

Cast To

CY B3 ES

Repeat Step 10 to choose your 2" destination and then press the [Start]
() button to send the scanned image to the destination.

Repeat Step 12 ~ Step 13 to send the scanned image to another
destination.

If you have finished distributing your scanned image to all the
destinations you want, press the [Back] button to exit the screen.
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Setting Up and Managing
Destinations

This section provides procedure for the administrator to setup and manage your
destinations including E-mail addresses or network folders to distribute the
scanned document on the network.

Setting Up Your E-mail Address Book

This section provides procedure for the administrator on how to setup E-mail
Address Book. The address book can be setup and managed either through the
LCD Touch Panel or the product’s embedded web page. This section uses LCD
Touch Panel as an example.

Adding a new E-mail Address

Follow these steps to add a new E-mail address.

1. On the Home screen of the LCD Touch Panel, select [Settings]>[Address
Book] in succession. The E-mail Address Book screen will be displayed.

" G r——

2 r
Y] Ve
Device o
Management Network
—-—
e )
Wulti-page PDF /(5 | ‘
> I ,
Filing Profiles. Address Book
-_— .

2. Tap [New] to prompt the [New E-mail Address] page.

nimo_wei nimo_wei@abc.com

3. Enter your E-mail address and its description.

4. Tap [Save] to save your address and leave the E-mail screen.
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Note:
Up to 200 E-mail addresses can be entered in the Address Book.

Editing a Current E-mail Address

To modify a current E-mail address,

1.

Repeat Step 1 from the previous section, Adding a New E-mail Address. The
[E-mail Address Book] page will be displayed.

Select the E-mail address which you want to modify from the list and then

tap [Edit] to prompt the [Modify E-mail Addresses] page.
Modify your address information.

Tap [Save] to save the setting and leave the E-mail screen. Or tap [Cancel]

to leave the page without saving any setting.

Deleting a Current E-mail Address

To delete a current E-mail address,

Repeat Step 1 from the previous section, Adding a New E-mail Address. The
[E-mail Address Book] page will be displayed.

Choose the address you want to delete from the list and then choose
[Delete] to erase the address. A Confirmation dialog box appears to

confirm your deletion. Click [OK] to confirm or [Cancel] to exit.
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Adding a new E-mail Group

To send multiple addresses simultaneously at one time, you can create address
group to speed up the process. Up to 50 addresses can be included in one

group and a total of 50 groups can be created in the Address Book.

To add a new E-mail group,

1. Repeat Step 1 from the previous section, Adding a New E-mail Address.
The [E-mail Address Book] page will be displayed.

2. Tap [Group] and then choose [New] to prompt the [Add a New Group]
page.

3. Enter your group name and its description.

4. Choose the address from the address list and click = to add a member to
the group.

Settings >> Address Book >> Group 2016/11/16/ 0507

[ Cancel ] [ Save ]
Name Description

[ ) [ ]

Edit Members

Contacts List Group Members

AV01419 tina_yang@abc.com
AV01420 irene_tseng@abc.co
AV01426 jerry_chang@abc.co 12 0

AV01445 steven_hsiung@abc

5. Click [Save] to save the setting or [Cancel] to leave the page without

saving any setting.
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Editing a Current E-mail Group

To modify a current E-mail group,

1.

Repeat Step 1 from the previous section, Adding a New E-mail Address.
The [E-mail Address Book] page will be displayed.

Tap [Group] and choose the group which you want to modify from the list
and then tap [Modify] to prompt the [Modify E-mail Group] page.

Modify your group information. Choose the group member you wish to
add and then click = to add the new member or click € to delete an old

member from the group.

Tap [Save] to save the setting and leave the E-mail screen. Or tap

[Cancel] to leave the page without saving any setting.

Deleting a Current E-mail Group

To delete a current E-mail group,

1.

Repeat Step 1 from the previous section, Adding a New E-mail Address.
The [E-mail Address Book] page will be displayed.

Tap [Group] and choose the group which you want to delete from the list

and then tap [Delete] to erase the group.

A Confirmation dialog box appears to confirm your deletion. Click [OK] to

confirm or [Cancel] to exit.
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Setting Up Your Filing Profiles

The section provides procedure on how to setup your Filing Profiles to send your
scanned document to a specified network folder. The Filing Profiles can be setup

and managed either through the LCD Touch Panel or the product’s embedded
web page.

Adding a new Filing Profiles

To create a Filing Profiles, follow these steps:

1. On the Home screen of the LCD Touch Panel, select [Settings]>[Filing
Profiles] in succession. The Filing Profiles screen will be displayed.

5E

—
BM2 Air

'ﬂ @?;

Account
Filing Default Management

Settings >> Filing Folder

FTP_PC o -
FIP_NB m
Filing_PC
Filing_NB 4

2. Tap [New] to prompt the [New Filing Profiles] page.

3. Enter your Filing Profiles information. Refer to the preceding section,

Creating Your Filing Profile (page 19), on how to enter your folder
information.

4. Tap [Save] to save your setting or [Cancel] to leave the screen without
saving these settings.
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Editing a Current Filing Profiles

To modify a current Filing Profiles,

1.

Repeat Step 1 from the previous section, Adding a New Filing Profiles. The
[Filing Profiles] page will be displayed.

Choose the Filing Profiles which you want to modify from the list and then
tap [Modify] to prompt the [Modify Filing Profiles] page.

Modify your folder information.

Tap [Save] to save the setting and leave the Filing Profiles screen. Or tap

[Cancel] to leave the page without saving any setting.

Deleting a Current Filing Profiles

To delete a current Filing Profiles,

1.

2.

Repeat Step 1 from the previous section, Adding a New Filing Profiles. The
[Filing Profiles] page will be displayed.

Choose the folder you want to delete from the list and then choose [Delete]
to erase the folder. A Confirmation dialog box appears to confirm your

deletion. Click [OK] to confirm or [Cancel] to exit.
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5 Starting a Scan from Your
Mobile Device

Connecting to A Wireless Network

Connecting to a Wi-Fi network in an AP (Access Point) Mode

In AP (Access Point) mode, your mobile devices and the scanner are connected
wirelessly without an additional AP (Access Point) since the scanner itself works as
an AP.

AP (Access Point)

Eﬂ

1. If you have connected a wired Ethernet cable to the scanner, disconnect the
network cable.

2. On the Home Screen of the LCD Touch Panel, tap [AP Mode]. In a second,
the SSID and IP Address will be displayed.

Settings >> Network

(e—
Wireless AP mode - PR

i\v address 192.168.43.1 ‘
| Network ssiD Avision-D6FOF2 ‘

| security Disabied

3. On your mobile devices, make sure Avision—xxxxxx (xxxxxx indicates the last
six digits of the Mac Address) has been selected as your network name
(SSID).

80



Connecting the Scanner to a Wi-Fi Network in a Client Mode

In a Client mode, your mobile devices and scanner are connected wirelessly
through an additional AP (Access Point). This mode is also the default wireless

mode. .
AP (Access Point)

>)

Connecting Your Scanner to an Access Point:

Important:

Note the wired and wireless mode can not work at the same time. To connect the
scanner in a wireless network, please first disconnect the Ethernet cable
connecting to your scanner.

1. If you have connected a wired Ethernet cable to the scanner, disconnect
the network cable.

2. On the Home Screen of the LCD Touch Panel, tap [Settings]>[Network].

Make sure that [Wireless Client] is turned on.

Avision

P

—-—
=R O
— .
BM2 Air ’6”] I ; x - ﬁ “5) ' >
Device I - Account
Management Network &-Mail Filing Default Management
» N

— 1
— | BN B L)
Filing Profiles Address Book Shortcut Service Mode

g Mail Server

E LDAP Server

=&l Credential Manager

Cancel
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3. In a second, current wireless networks near you will be displayed as shown

below.

Settings >> Network

o =
A ®(5)
Wireless P

SMCWBR14S-NL

Connected

1921682100 FapsserBo9ec il

DSR-500N_WPAPSK
Secured with WPA

all

DSR-500N_1
il

DSR-500N_WPA2PSK

Secured with WPA2

il

AVISION-206
il

Ruffalo-G-19RA

4. Select an Access Point and click [Connect] to connect the scanner to a
specified Access Point, for example, SMCWBR14S-NL. In a few seconds, if the
connection is successful, the IP address and Mac address of the scanner will

be displayed as indicated above.

Note:
If your access point is set to not broadcast the SSID, please follow these steps to
manually add the SSID name (network name):

1. On the wireless page, tap the [More Settings]> button and then choose
[Add network]. The [Add network] page will be displayed.

Settings >> Network

oy Yt
) : ( ),
Wireless 3 ) o | —
= Add network o
i o . Add network
oG
SMCWER14S N ro216a21 1 WesTushedion
WPS Pin Entry Network SSID
AVISION-206
il ‘
DSR-500N_1 ull :
Security
S al > 4
edimax-n11
' ' ! i Show advanced options
TP-1INK 2 4GH7 AC94Da
Cancel

2. Enter the Network SSID name and choose the security mode, encryption
type, and network key and then tap [Save] to search the wireless network
manually.

Your scanner supports the following authentication methods:

Security mode Encryption method Key Index
WPAPSK TKIP, AES, TKIPAES X
WPA2PSK TKIP, AES, TKIPAES X
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Connecting to a Wireless Access Point Using the WPS Button

You may connect the scanner to a WPS compatible wireless access point by

pressing the WPS button on the back of the scanner.

Before You Begin!
To enable the WPS connection of your access point, please refer to the user’s

guide of your access point.

Perform the following procedure to connect.

1.

4.

Confirm your wireless access point/router has the WPS or AOSS™ symbol as
shown below.

AOSS’

Press the WPS button of your wireless access point. (You may refer to the
user’s guide of your access point/router for instructions on how to use the

WPS button.)

"

On the Home Screen of the LCD Touch Panel, tap [Settings]>[Network].
Make sure that [Wireless Client] is turned on. On the wireless page, tap

the [More Settings]> button and then choose [WPS Push Button] for at
least 2 minutes.

( ON L ;) ]
Wireless S LI— ] - -
(B et
19216821 _

SMCWBR14S-NL WPS Push Button '
Connected —-— —
WPS Pin Entry

AVISION-206 |
all ‘

DSR-500N_1
- ull
DSR-500N_WPA2PSK
ecured with WPA2 il
edimax-na11
WPS available wlll

TP-1INK 2 4GH7 AC94D9

If the connection is successful, the Wi-Fi LED light of the scanner will turn
solidly on and the connected AP name will be displayed on the page as
indicated below.
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Settings >> Network

=
5
o
z
=\
v 9
=
L9

. ————————
SMCWBR14S-NL
Connected

e L R R R
DSR-500N_WPAPSK
Secured with WPA
DSR-500N_1
DSR-500N_WPA2PSK
ecured with WPA
AVISION-206

|__Buffalo-G-19RA

Scanning a Document from a Mobile Device

Make sure that the MB Application (Scan App) has been installed on your mobile
device. The MB Application can be purchased for free from an application store
such as Google Play.

1. Enable [Wi-Fi] from [Settings] of your wireless computer, smartphone, or
tablet and then choose the same network name (SSID) of your scanner. For
example, SMCWBR14S-NL.

ClaireAP
DSR-500N_1

ED WI-FI

Willie_Huang

2. Tap the MB app () on the screen to launch the Scan Application. The main
window will be displayed and the application will automatically search a
scanner in the same wireless LAN. If successful, [Start scan] will be
displayed at the bottom as shown below.

150 | a0 | &) 4 | & ATTENTION:
Duple | Cokr If the scanner is not found, please check the
followings:
1. The scanner is not ready yet. Tap [More
Settings] and then [Search scanner]
to search the scanner again.
2. Check if the mobile device and the
scanner are in the same wireless LAN.
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3. Check if the default settings meet your requirements. If not, change the scan
settings to fit your specific scanning task.

Item Description

200 Resolution: Select your desired resolution. The higher

DPI

resolution, the greater the image quality and disk space.

Choice: ¥*150, 200, 300 dpi

AUTO Scan Size: Select your paper size or you may choose Auto
SIZE

to let the scanner detect your document size automatically.
Choice: *Auto size, A4, LTR (Letter), LGL (Legal), 4x6,
5x7

File Format: Select the file format for your image.

Bl

Choice: *JPEG, PDF, TIFF

Note:
e The JPEG file does not support the B&W image.
e The TIFF file format supports only the B&W image.

Select to scan the front side (simplex) or both the front side

and the rear side (duplex) of your document.

Choice: *Simplex, Duplex
Note: The duplex mode is available to scan from the auto

document feeder only.

== Color Mode: Select your desired image mode.

Choice: *Color, B&W, Gray

* Default settings

4. Load a page to the auto document or place a page on the flat bed.

5. Tap the [Start scan] button. (Choose your scanner if there is more than
one scanner connected to the network). In a second, the scanner begins
scanning the document and the thumbnail scanned image will be
displayed.

The
Thumbnail
Image

6. Tap the thumbnail image to view the entire image.
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Customizing the Product’s
Configurations

This chapter is specifically targeted to the persons who are responsible for the
administration of the product. It is recommended that the administrator read this
chapter before installing the machine.

The product’s configurations can be customized via the LCD Touch Panel. In
addition to using the touch screen, the product allows the administrator to
remotely configure the machine by launching the product’s embedded web page.
How to customize the product’s configurations via these two methods will be
described in the following sections.

Note:

When installing the product for the first time, it is recommended that the
Administrator retain the default system settings. The settings can be customized
at a later date once you are familiar with the operation and functionality.

Customizing the Product’s Configurations by the
Touch Screen

Press the [Settings] button on Touch Screen. Please login with the default user
name and password — [admin]. The password can be changed later in the web
page.The [Settings] screen will be displayed as indicated.

rm— (G
r A
Z8 1A
%
Network E-Mail Defa Filing Default
\ [T\
a )
it | Shertcut >
Address Book Shortcut

Settings

These 8 buttons displaying at the top are: General, Network, E-mail Default,
Filing Default, Filing Profiles, Address Book, ShortCut, and Service Mode. For
details on each setting, please refer to the subsequent section, Summary of the
Product’s Configurations.
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Customizing the Product’s Configurations by the
Product’'s Web Page

1. Open your browser.

2. Type the IP address of the product in the URL field of your browser and
then press Enter. The product’s embedded web page appears.
|

WebMandagerg

Information “
Scanner
Model Name: Avision AN360FW Reverse Roller Count: 1044
Host Name: Avision-012345 Pick-up and Separation Roller Count: 1044
Serial Number: A096691297250002  ADF Simplex Count: 444
Firmware Version: 0.73 ADF Duplex Count: 600
Born Date: 2019/8/8 Multi-Feed Count: 0
Jam Count: 0
Network
Wired
1P Address: 10.1.20.171
MAC Address: 000232014085 WV

3. To access complete information of the web page, please login with the
default user name and password - [admin]. The password can be changed
later in the web page.

Admin|__ Logout |

Hblr:\hFii},}f'r '
gheretd

Information | ~
Scanner
Model Name: Avision AN360FW Reverse Roller Count: 1044 Reset Roller Count
Host Name: Avision-012345 Pick-up and Separation Roller Count: 1044 Reset Roller Count
Serial Number: A096691297250002  ADF Simplex Count: 444
Firmware Version: 0.73 ADF Duplex Count: 600
Born Date: 2019/8/8 Multi-Feed Count: 0
Jam Count: [
Network
Wired
1P Address: 10.1.20.171
MAC Address: 000232014085 v

Click each item under these tabs to set up relevant values. For details on
each setting, please refer to the subsequent section, Summary of the
Product’s Configurations.
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Summary of the Product’s Configurations

Information: Used to show the product’s basic information.

Scanner

Items

Description

Model Name

Used to show the product’s model name.

Host Name

Used to show the product’s host name (Avision-xxxxxx) for
the scanner in a wired and wireless environment. XXXxxx
indicates the last six digits of the scanner’s Mac address.

Serial Used to show the product’s current time. The time
Number format is 24-hour system.

Firmware Used to show the firmware version.

Version

Born Date Used to show the manufacturing date.

Scan Count

Scan Count including Reverse Roller Count, Pick-up and
Separation Roller Count, ADF Simplex Count, Multi-Feed
Count, and Paper Jam Count.

Reset Roller Count: Click this button to reset roller
count after roller has been replaced.

Network

Items Description

Wired Used to show the product’s IP and Mac address in a
wired network environment.

Wireless AP Used to show the IP and Mac address of the product’s
AP (Access Point) in a wireless network environment.

AP Mode Used to show the product’s SSID (network name) and

IP address in a wireless network environment.
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Device Management

General: Used to specify the product’s general information.

General

Items

Description

Host Name

Avision-xxxxxx: The network name (SSID) for the
scanner in a wired and wireless environment. Xxxxxx
indicates the last six digits of the scanner’s Mac
address.

NTP Server Used to specify the product’s NTP server.

Date Used to specify the product’s current date.

Time Used to specify the product’s current time. The time
format is 24-hour system.

Time Zone Used to specify the time zone of your location.

Power Saving

Used to specify the length of time the product needs to
enter the power saving mode after last action. Range: 1
~ *60 minutes

Enable Auto Check to enable auto power off. Range: *0 ~ 480
Power Off minutes
Screen Off Enter the length of time the product turns off the screen

after the last action.
Choice: *Never, 3 min, 5 min, 10 min

Device E-mail

Enter device’s e-mail address. This address serves as

Address [Report to E-mail] address in Filing function if you
wish to send the filing report to an E-mail address.
Multi-Feed Choose if you wish to enable the Multi-Feed Detection
Detection via ultrasonic unit. Ultrasonic Detection allows you to
default set overlapped document by detecting paper thickness

between documents. Choice: On/*Off

Admin Profile

Used to specify the login name and password to enter
the product’s web page.

E-mail Address: used to specify the administrator’s
E-mail address.

Reset to User

Set timeout time if user has taken no action and then

Default the system returns to the main screen. Choice: 30
Sec/1 Minute/3 Minutes/5 Minutes

Auto Add Choose [On] if you wish a new e-mail address to be

Contact to automatically added to the Address Book. Choice:

Address Book

Oon/ *Off

Function Lock

Scan to USB

Used to enable or disable the function. Choice: *ON/OFF

Scan to Public
Folder

Used to enable or disable the function. Choice: *ON/OFF
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A* Manager Settings

A" Manager
Settings

Check [Enable] and then enter the IP address of a
specified server to send the system log file to for quick
troubleshooting.

* : Factory Default

Network: Used to specify the product’s network settings.

Items Description

Wired

Obtain an IP Used to specify if the product’s IP address is assigned
address by DHCP or a static IP.

automatically

Choice: Off, On

If you have a DHCP server available on your network
and the DHCP has been enabled, the IP address, subnet
mask, gateway, and DNS server will be automatically
given.

IP Address The Internet Protocol (IP) address
assigned to your machine by your
network administrator.

Subnet Mask | The net mask address assigned by
your network administrator.

Gateway IP The gateway IP address assigned by
your network administrator.

DNS Server The Domain Name Server assigned
by your network administrator.

WIN Server | The WIN Server assigned by your
network administrator.

Mail Server

Items

Description

Mail Server

Enter the IP address of your SMTP server (mail server).

SMTP Port #

Enter the port number of the SMTP server.
* 25

Authentication
Method

Choose to enable the email authentication method.

Choice: OFF, *ON

Encrypt

Choose the encryption method of your emails to the
SMTP server.

Choice: *None, TLS/STARTTLS, SSL

Login Name

Enter the login name for SMTP authentication.

Password

Enter the login name for SMTP authentication.
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LDAP Settings
Items Description
Authentication | Enter the IP address of your LDAP server and its port
LDAP number.
New Setup a new LDAP setting.
Enter IP address and port number of your LDAP server,
Login name and password to access the LDAP server,
and search information.

Note: Check LDAP server information with your
Network Administrator.

Delete Delete a current LDAP setting.
Modify Modify information of a current LDAP setting.
* : Factory Default

E-mail Default: Used to specify the product’s default scan settings for E-mail.
The default scan settings include 5 tabs which are Basic, E-mail Option, Advanced
Settings, Layout Adjustment. For more details on the options of each tab, please

refer to the setting description on the preceding section, Scanning and Sending

Your Documents to E-mail Addresses on page 30.

Filing Default: Used to specify the product’s default scan settings for Filing. The
default scan settings include 5 tabs which are Basic, E-mail Option, Advanced
Settings, Layout Adjustment. For more details on the options of each tab, please
refer to the setting description on the preceding section, Scanning and Sending
Your Documents to a Network Folder, a USB Flash drive or a Public Folder

on page 35.
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Filing Profiles: Used to setup and manage your file destinations including FTP,
SMB, USB (an inserted USB flash drive), or a Public Folder (the machine’s

memory).

Items Description

Add Add a new Filing Profiles.

Enter information on the [Basic], [Advanced Settings],
[Layout Adjustment] tabs.

For more details on the options of each tab, please refer to
the setting description on the preceding section, Scanning
and Sending Your Documents to a Network Folder, a USB
Flash drive or a Public Folder on page 35.

Delete Delete a current profile.
Modify Modify a current profile.
Folder Name | Used to specify the folder name for the destination.

Address Book: Used to create or edit your address book. Options include Add,

Modify, Delete, and Group.

ShortCut: Used to set up the product’s ShortCut displayed on the LCD touch

panel.
Item Description
Destination Choice: USB Flash, Public Folder, FTP, FTPS, FTPES,

SMB, SharePoint, E-mail.
Option: New, Edit, Delete
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Account Management: Used to define users and set user’s privileges including
using the copy, E-mail, cloud, or filing function of the product by assigning an

account’s authentication method.

Basic

Items Description

Enable Security Check to implement security by setting up
Management accounts and enabling LDAP authentication.

Enable Guest Account

Check to allow guest accounts.

Enable LDAP Authentication

Check to enable LDAP authentication.

Default Enable Function

Check the names of functions (ShortCut, Cloud,
E-mail, Filing, Scancast) to be allowed to
perform.

Account List

Items Description

New Setup a new account.
Enter User Name, Password, E-mail Address,
check the functions to be allowed to perform,
and check if using LDAP authentication.

Delete Delete a current account.

Modify Modify information of a current account.

Firmware Update: Obtain the latest firmware file from the web site

(www.Avision.com) first. And then click [Browse] to find the file on your

computer. Finally click [Update] to update the latest firmware to the product.
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Configurations Customized Only Via the LCD Touch
Screen

There are some activities which can be set only through the LCD touch screen, for
example, the service mode. The service mode is set to provide saving system

log file, updating firmware for quick troubleshooting your problems.

Accessing the Service Mode

To access the service mode,

On the product’s LCD screen, choose [Settings] and then [Service Mode].
2. The Service Mode screen will be displayed with following options: [FW
Updated], [Reset to Default], [Run-in Test], and [Save Log].

FW Updated: Follow these steps to update the firmware:

1. Locate the latest firmware file from the web
site (http://www.Avision.com).

2. Store the firmware file on your removable USB
disk.

3. Plug the removable USB disk into the USB disk
port of the machine.

4. Tap [FW Updated] to update the firmware
file.

Reset to Default: Choices include [Reset Admin], [Reset Network
Settings], [Reset Admin and Network], [Reset
to Factory Default].

Reset Admin: Reset the login user name and
password of the product’s web page.

Reset Network Settings: Reset the network settings
to factory default.

Reset Admin and Network: Reset both the login
information and the network settings to default.

Reset to Factory Default: Reset all configurations to
factory default values.

Run-in Test: For internal use only.

Save Log: Plug a removable USB disk into the USB port of the
machine and tap [Save Log] to save system log
file.
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Adjusting Brightness
To adjust brightness on the LCD screen, follow these steps:
1. On the product’s LCD screen, choose [Settings] and then [Device

Management].

2. Tap the [Brightness] option and move the scroll bar to the right to increase

your brightness or to the left to decrease your brightness of the LCD screen.

Selecting Language
To select the language, follow these steps:

1. On the product’s LCD screen, choose [Settings] and then [Device

Management].

2. Tap the [Language] option and select your language display on the LCD
screen. Choice: English, Chinese Traditional, Chinese Simplified, Spanish,
Portuguese, and Hebrew.

3. Tape [Save] to save the settings.

Installing Credential Manager

Some LDAP servers may require credential information as the authentication

method. To install the Credential Manager, follow these steps:

1. Store your Credential Manager in your removable disk drive.
On the product’s LCD screen, choose [Settings] and then [Network].

3. Tap the [Credential Manager] option and tap your file. The product begins
installing your Credential Manager.

4. In a second, the installed file will be displayed on the LCD screen.
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Configurations Customized Only Via the Product’s
Web Page

There are some activities which can be set only through the product’s web page.
For example, some options on [Device Management], [Import/Export], and
[Public Folder]. How to use these options will be described in the following

sections.

Exporting and Importing System Data

To easily manage several AM360FW in the network, the machine provides a useful
feature to allow system administrator to export the system data of one AM360FW
into a file and then import this data to other AM360FW in the network.

For example, the address book, Filing Profiles, and default systems settings of one
AM360FW can be first exported to a file as a backup and then import these files to
other AM360FW.

Follow the procedure described in below to export and then import your system
data.

To export system data,
1. On the product’s web page, choose [Import/Export].

2. Choose the system data you want to export. Choice: Address Book, Filing
Profiles, Settings (Device Management, Account Management, Mail
Server/LDAP Server, E-mail Default, Filing Default).

3. Choose [Export Now]. The selected system data will be exported into a file.
If [address book] is selected, an AM360FW_addressbook.csv file will be
generated. If [Filing Profiles] or [settings] is selected, an
AM360FW_profile.json or AM360FW_setting will be generated...

4. Save the exported file into your computer as a backup.
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To import system data,
1. On the product’s web page, choose [Import/Export].

2. Choose the system data you want to import. Choice: Address Book, Filing Profiles,
Settings (Device Management, Account Management, Mail Server/LDAP Server,
E-mail Default, Filing Default).

3. On the Importing option, choose [Browse] to locate the system data which you
have been previously exported.

4. Choose [Import Now] to start importing the system data to your machine. The
current system data will be overwritten.

Accessing the Public Folder

The machine allows you to save the scanned image temporarily to the product’s
memory and then access the scanned image through the product’s web page. To

access the scanned image, follow these steps:

To access the scanned image,

1. On the product’s web page, choose [Public Folder].

2. A PIN number dialog box appears. Enter the PIN number which you previously
set during scanning to access the public folder.
*If you are an administrator, you can click [OK] on the [Public Folder File
Explorer], then you can access all scanned files without entering the PIN
number.

3. Choose your scanned file on the [Public Folder] and click [Download] to
download the file to your computer.

Note:
The scanned images can be saved on the product’s memory for 24 hours only.
After 24 hours, the image files will be automatically deleted.
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Using the Product as a
Regular Scanner

Installing the Scanner Driver

Note:

e To ensure your computer can identify the USB scanner, please install scanner
driver first before connecting the scanner to your computer.

e The scanner driver contains TWAIN, ISIS and WIA driver. After the installation
of scanner driver is completed, this scanner allows you to scan via a TWAIN,
ISIS, or a WIA interface. Start your TWAIN-compliant image editing software
application to select a TWAIN or WIA user interface or your ISIS software to
select an ISIS user interface. You may also launch Microsoft’'s Scanner and
Camera Wizard to scan via a WIA user interface.

1. Place the supplied CD-ROM onto your CD-ROM drive.

2. The software installation graphic appears. If not, run “setup.exe”.

AViSion ‘/{é\mm www.avision.com
image

A vision of your office

To ensure Button Manager V2 work properly, please FIRST install scanner
driver before installing the Button Manager V2.

Install Virtual Scanner Link
Install AVScan X

View Manuals

Contents on the installation graphic:

Install Scanner Driver: To communicate with your scanner, you need to
install the scanner driver.

Install Button Manager V2: To use the [BM2 Air] function, you need to
install Button Manager V2. To ensure Button Manager V2 works properly,
please FIRST install scanner driver before installing Button Manager V2.

Install Virtual Scanner Link: To connect your computer to the scanner in
the network, you need to install the Network Setup Tool. *Virtual Scanner
Link: The availability of this software varies according to your model.

View Manual: Click “View Manual” to view or print the detailed user
manual for the scanner and Button Manager V2 respectively.

Click Install Scanner Driver to install the scanner driver unto your computer.
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Connecting to the Computer

Via a USB Cable

1. Connect the square end of the USB cable to the USB port of your scanner.
Connect the rectangle end to the USB port at the rear side of your computer.

Note:

The scanner is designed with a USB 3.2 Gen 1X1 interface to ensure the
optimal speed. If your computer comes with a USB 3.2 Gen 1X1 port, make
sure to connect the scanner to your computer to the USB 3.2 Gen 1X1 port
which is distinguished in blue color at the back of your computer. The USB
3.2 Gen 1X1 port enhances your scanning speed and is also compatible with
USB 2.0 and USB 1.1.

S

=

w)

2. The computer should detect a new USB device and prompt a "New
Hardware Found” message.

3. By following the on-screen instructions, click the Next button to continue.
When the certification screen appears, click Continue Anyway to complete
the installation.

4. When the Finish dialog is prompted, click the Finish button.

Via a Wired Network

1. Connect one end of your Ethernet LAN cable to an available port of your
Ethernet Hub.

2. Connect the other end to the port marked % at the back of the product.
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Connecting to the Network Scanner

Before connecting to the network scanner, make sure that Virtual Scanner Link
(Network Setup Tool) has been installed onto your computer. The Network Setup
Tool is included in the supplied software CD.

1. Start [Virtual Scanner Link] by choosing Start>All Programs>Avision
Virtual Scanner>Virtual Scanner Link. The main window will be displayed
and the scanners in your network will be searched automatically. In a few
seconds, the result including the scanner model and scanner’s IP address will
be displayed as shown.

& Virtual ScannerLink - &= (L=

Virtual Scanner Link [ietesh g Setihes

2. Choose the scanner you wish to connect and then press [Connect]. If
connection is successful, a connection mark will be displayed as shown.

& Virtual Scanner Link " — . (=) L=

... Virtual Scanner Link | Rt || song

3. After the scanner has been connected successfully, launch your
TWAIN-compliant image-editing software application to start a scan.
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Note:

The network scanner can be used by one user at a time. If the network scanner is
being used by other user, you will be prompted with a message to connect the
scanner later. When the scanner is available, you will also be prompted with a
message to connect the scanner and start scanning your document.

If the network scanner has not been found, it is probably the scanner and your
computer are not in the same LAN. In this case, you can assign a specific IP address
of the scanner to let [Virtual Scanner Link] automatically search the scanner. Click
the [Option] button, type your IP address on the [Searching Address] field (1), then
click the [+] button (2) and finally click [OK] (3) to complete.

¢ Options [d_:hj

Logaes [Eagi S

b
I
(=]

=8

Searching Time: 5 (5~20sec.)

(2) = Sehmeddies il g . 1 23 .47 || (2)
—

(3 [ ok || Coxa |

= v,

Searching Time: When the program is launched, it automatically searches the
scanner in the network in 5 seconds (default). The searching time can be changed
from a range of 5 to 20 seconds.

If the [Virtual Scanner Link] program has been closed and then launched again,
[Virtual Scanner Link] will automatically search and connect the network scanner it
has previously connected to.
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Verifying Your Scanner Installation

To verify if your scanner installation is correct, Avision provides you a useful test
program called Avision Capture Tool. With this tool, you can perform simple scans
and view the captured images. In addition, it helps you complete your scan at a
rated speed.

The following procedure describes how to verify your scanner installation. If the
installation is not correct, please review the preceding section to check if the cable

connection and scanner driver have been successfully installed.

Before you begin, be sure the scanner is on.

1. Select Start>Programs>Avision xxx Scanner>Capture Tool. The Select Scanner
Model dialog box will be displayed.

Select Scanner Model

Driver Type:

TN

Scanner Model:
AviSion oK ~

v Cancel

2. Select your driver type and scanner model and click OK. The following Avision
Capture Tool dialog box will be displayed.

Fit Actual
Page Size

¥ Avision Capture Tool (TWAIN) - XXXx

File View Abont

-@smn g | e [mmp o] oy Scamage Fl [
sl o }

| ! | |

Save i File Path
Setup  gean File Format

3. Choose your desired file format from the File Format drop down list box.
(Default is JPEG, other choice includes TIFF, MTIFF, PDF, MPDF, GIF, and BMP.)

4. Type your desired folder name and file name in the File Path box. (Default is
C:\Documents and Settings\User Name\My Documents\My Scan\Image.)
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Note:

If you do not wish to save the scanned image, deselect the Save button since
default is Save Enable. In this case, the thumbnail view will be disabled. And
therefore, after viewing all the scanned images, only the last one will remain
on the screen.

%, Se
5. Click the Setup button ( “*% tulJ) or choose Setup from the File menu to prompt
the Scanner Properties dialog box.

> Scanner Properties =
B P
B Sensiviy K =
B —

Image — | _
. et ) o ——
Selection ™ E— |
B B T—
oX ST —

] Same settings for both sides:
Scan Source: | Auto Document Feeder: -

Profles... ] [Custom 7]

6. From the Image Selection Box, choose your desired image type for your
scanned image. (Default is Front B&W) If you have a duplex scanner, choose
Front and Rear to scan both sides of your document.

7. Click OK to quit the Scanner Properties dialog box. (To learn more details
about the Scanner Properties dialog box, please see the subsequent chapter,
Using the Scanner Properties Dialog Box.)

8. Place your document face down on the document glass or face up in the auto
document feeder.

> Scan
9. In the Scan Validation dialog box, click the Scan button ( A ) or choose
Scan from the File menu.

10. The document will be scanned and displayed in the Scan Validation screen.
After the scanned images have been displayed, your scanner installation
verification is completed.

- g 25 ¥

11. You can view the scanned image in Fit Page (l ) or Actual Size (100%)

button (D ) from the Viewing toolbars at the right side.
12. Click the Close box or Quit from the File menu to exit the Scan Validation Tool.
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A Glance of the Scanner

Properties Dialog Box

- Scanner Properties ==
1 Image | Paper [ Setting | Infomation
Front Auto Color Detection ] Binarization: (Dmamic Threshod ~~~~~ ~|
2 1 [Front Color ] Senstiviy: 204
O [fotGey ] 3
a4
7] [Rear Auto Color Detection | Resolution (dpi) o S 5
CI— o ‘ 6
7 RearBOW ]
T e i 3 7
Profies... | [Custom -
8 | x| ) )

1. Tab Options Choice: Image, Compression, Color Dropout, Paper,
Multi-Feed Detection, Preview, Options, Settings,
Information.

2. Image Selection |Choose your image type and the side of document you

Box wish to scan. Options vary based on type of scanner.

3. Brightness Adjust the brightness level from -100 to +100.

4. Contrast Adjust the contrast level from -100 to +100.

. Determine the quality of the scanned image. The

5. Resolution industry standard is 200 dpi.

6. Invert Reverse the color of your scanned image.

7. Scan Source Choice: Auto Document Feeder, Flatbed, Flatbed
(Book), Automatic (varies due to different scanner
model)

8. Defaults Reset all values on the tabs to the factory default

settings.
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Using the Scanner Properties
Dialog Box

The Scanner Properties dialog box allows you to configure the scanner’s settings. It

consists of several tabbed windows each of which will be described in this chapter.

Note:
In this chapter, all options are available based on a duplex (double-side) scanner. If
you have purchased a simplex (single-side) scanner, all options are available for

single sided only.

.z Scanner Properties ==

Image | Paper I Setting I Information

E Senstivity: 20 ¢ *

[ Resolution (dpi): Iﬁm
[

[7] Same settings for both sides

Invert (Black on White ~

Scan Source: [Aulo Document Feeder ']

Profies... | [Custom -

o

The Scanner Properties dialog box
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Buttons on the Scanner Properties Dialog Box

.2 Scanner Properties @
Image | Paper [ Setting | Information |

] Binarization: [DynamicThneshold v]
] Sensttivity: 20 ¢ | L
T —

E Resolution (dpi): [200 ']E]
] [RearColr |
.
[ BearB8W |

["] Same settings for both sides

Invert: [Black on White v t

Scan Source: [Auko Document Feeder ']

Profies... | [Custom -]

The buttons on the Scanner Properties dialog box

Buttons Description

Defaults | Click the Defaults button, the factory default settings will
be shown on each tab.

Cancel Click the Cancel button to leave the Scanner Properties

dialog box.
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The following table shows the default settings :

Tab name

Default settings

Image

Image : Front B&W

Binarization : Dynamic Threshold
Resolution : 200 dpi

Invert : Blank on White

Scan Source : Auto Document Feeder
Threshold : None

Brightness : None

Contrast : None

Compression

None

Color Dropout

None

Paper

Cropping : Automatic
Deskew : Yes
Orientation : Portrait
OverScan : 0.00

Note: The availability of this option varies
due to scanner model.

Unit : Inch
Multi-Feed None
Detection
Preview None
Options Rotation Degrees : None
Blank Page Removal : None
Edge Fill : White - 0 mm
Image Control Option : None
Setting Enable Energy Saver : Enable, 15 minutes
after last scan action
Show Scanning Progress : Yes
Show Warning Message : Yes
Save Settings after Closing : Yes
Imprinter Digital Imprinter
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Showing or Hiding Tabs

The [Scanner Properties] dialog box is displayed in default with three basic tabs

- Image, Paper, and Information. To show more tabs, click the [Scanner

Properties] icon to access more scan settings.

To show more tabs,

1.

Click the [Scanner Properties] icon (B) on the upper left corner, and
choose [Tab] to show available tab names. The available tabs include
Compression, Color Drop out, Preview, Rotation, Separation, Multi-Feed,
Options, Settings, and Imprinter. (Note: the options vary based on scanner
model.)

Choose the tab you want to display. The selected tab will be shown with a
check mark and then displayed in the [Scanner Properties] dialog box.

. To access the settings, click the selected tab on the top of the [Scanner

Properties] dialog box. The page of the selected tab will be displayed.

To hide a tab window,

1.

2.

Click the [Scanner Properties] icon (B) on the upper left corner, and
choose [Tabs] to show available tab names.

Choose the tab you want to hide. Then, the selected tab will be hided in the
[Scanner Properties] dialog box.
Note: The [Image], [Paper], and [Information] tab can not be hided since

they preprogrammed to be displayed by default.

s> Scanner Properties @

Tabs » Compression

e, Color Dropout

x  Close Alt=F4 Multi-Feed Detection amic Threshold ,J

o B R ®
P Rotation

|Front Gray
[¥] ||Front B&W.

e Enhancement
v | Setting

m- Imprinter —v“:
7 [RearColr |
B ReaGey ]
) [RearBOW |

Separation

Invert [Biack on White )

Same settings for both sides

Scan Source [Auto Document Feeder ']

Profies... | Custom -]

[ Defauls ok | [ Cancel i

108



The Image Tab

The Image tab allows you to choose the front side and (or) the rear side of your
document, the type of image, and to set several basic scan settings. Note that
except for the resolution, you can set individual scan settings for the front side and
the rear side. For example, all settings in the Image tab, Compression tab, Color
Dropout tab can be set individually for the front and the rear side. However, the
settings in the Paper tab, the Option tab, and the Setting tab have to be set the
same for the front and rear side.

.22 Scanner Properties @

image. | Paper | Setting | inomation]

[ [Front Auto Color Detection Binarization: [Dynamic Threshold ']
[ [Front Color Sensitivity: 20 ¢ ’
[T [Front Gray

5 1 < )

@] |[Front B&W

0 Resolution (dpi) (20 ) E

[7] |Rear Color

Sl —

[ |Rear B&W

Invert: [Black on White V]

[7] Same settings for both sides

Scan Source: [Aulo Document Feeder ']

Profiles... ] [Cus!om v ]

o

The Image tab dialog box
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The Image Selection Box

tont Auto Color Detection

o0 ke The Image Selection box includes the image type and
"ot Gray document side option. If you wish to scan both the
ot B front side and the rear side of your color document,
you can check both Front Color and Rear Color at the
same time. Note the options vary based on type of
scanner.

Oo0o™0O

ear duto Color Detection
ear Color

=

ear Gray
ear BEW

00 O

Example 1 : Scanning a two-sided color document, both sides in color

O
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Side/Image
Selection

Rear

Example 2 : Scanning a two-sided color document, one in B&W, the other
in color

ront Auto Color Detection

tont Colo

ront Gray
ront BEwW
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et Colot

eal Gray

000

ear B

Side/Image

Front
Selection Rear

110



Image Type Description

Color Choose Color if you wish to scan a color image for
your original in color.

Gray Choose Gray image if your original contains actual
shades of gray.

B&W Choose B&W if your original contains only text,
pencil or ink sketch.

B&W Gray

Front/Rear Auto Color Detection:

Click to automatically detect and scan the front or the rear page of your color
document in color image mode. If your document is in colors, the scanner will
automatically scan the document into a color image. If your document is
non-color, you can choose the output to be either B&W or Gray from the Non-Color
Selection option. This option is useful when you have a mixture of color and

non-color document.

Note:
If you choose Front Rear Auto Color Detection, you can not specify the image
mode of your rear page and vice versas.

Modes of Auto Color Detection:

If [Front/Rear Auto Color Detection] is selected, its modes will be displayed.
Choice includes Normal, Ignore paper color. For paper with background color
such as invoices, choosing [Ignore paper color] will automatically remove the
background color and enhance the detection accuracy.

INVOICE INVOICE

e gp im0 B iy, e @ apize Dan: 2y e

INVOICE of INVOICE of

1 Tor sccwmt wd ik of Mowers_ A Maratscbming Co Lk
236 Wk A, Sntle, WA P41 US A TH 253913 6499 et 2336 Tax 293970 4681 odle, WAIH01 US A T s e
e Dt Wng A N Dkt Wing.

Spetby T Ul oo Srgeldy 55T Tudnalopes Inc Te Ulmekgess
Sulingen e sbet Ty 3000 T Tiwan RO € w Usa Sulingoner dod I I0 147 Tren T R OC * Usa
vew Cosrat e 4125 Ve Cantratle AT

a4 e o Gecks
<aec ]

Seal
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Normal Ignore paper color
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Sensitivity of Auto Color Detection

If your documents contain primarily B&W text and small amount of light or pale
colors and you do not wish them to be recognized as color image to save the file
size, you can increase the sensitivity value by moving the bar to the right to let
these images to be detected as B&W. The value ranges from 1 to 100. The
default is 37.

Standard TEEE 302,11 b/g/n standards compliant
Wiraless LaN 1TIR Made B |

Frequency Range | 2.400 ~ 2.4B35GHz [ subject to local requiations)

B02.110: 20MHz/40MHz

Numbar &6 {2.412GHz~2.462GHz)
| seiectable 8021

1br:
Japan (TELEC): 14 channels
(2.4126H2~2.4B35GHz)

| 802.11n: up ta 150Maps T

BO2.110: 1, 2, 5,5, 11Mbps
B02.11q: 6, 9, 12, 18, 24, 36, 48, S4Mbps
130 HT40 14CST - +13 dBm

Transmit

119 OFDM: +15 gBm
Power(EIRF)

11 CEK: +18 dBm

IS«umy WEF 64128, TKIR, WPA, WPAZ mixed, 502, L and 802,111

Original

Standard JEEE 302,11 b/g/n stam u Standard JEEE 802,11 bg/n standards compliant
Wireless Lan 1T2R Mode | Wiralass LaN 1718 Mode. - T

Frequency Range | 2.400 ~ 2.4B35GHz [ subject to local requlations) Frequency Range | 2.400 ~ 2.4B35GHZ { subject to local regulations) |
B02.11n: 20MHz/40MHz B02.11n: 20MHz/40MHz

USA,  Canede  (FCCE11  chamnels USA, Cenede  (FECKNL channels

Mumber of (2.4126H2~2.962GHz) HNumber of (2.412GHz~2.4626Hz)

Selectable 8021 | selectanie 8021

Channels Toro, | EuToPe (CEY: 13 cnanneis (2,41 2602~ 4726H2) Channsle 1bjg: | E9TOP® (CE): 13 channels (24126Hz~2.4726H2)
Japan (retEcy: 14 channels Japen (TELEC): 14 ehannels
(2:4126122.4835GHz) { (2.4126H2~24835GHz)

B02.11n: up to 150Mbps B02.11n: up to 150Mbps i

B0Z.11b: 3, 2, 5,5, 11Mbps B02.118: 1,2, 5,5, 11Mbps

B02.11g: 6, 8, 12, 18, 24, 36, 48, S4Mbps B02.119: 6, 9, 12, 18, 24, 36, 48, S4Mbps.

110 HT40 MCS7 - +13 dBm 150 HT40 1MCS7 - +13 dBm

Transmit .
Power(EIRP) F1 OFOM: 425 6Bm 11g OFDM; +15 dBm
1th O0K: +18 ébm 110 COK: +18 dBim

Security WEF 64/128, TKIF, WPA, WPA2 mixed, 502, x and 802,111 Ismm’ WER 647128, THIP, WA, WPAZ mived 02 1x and 802,111

Sensitivity: 1 Sensitivity: 100

(The image is recognized as a (The image is recognized as a black

color one) and white one)

Same settings on both sides:

Click to apply same scan settings for both sides of your documents. After checking
this option, any settings you have changed will automatically applied to both the

front side and the rear side. For example, if you choose your ideal resolution to be
300 dpi, this will be applied both to the front side and rear side of your document.
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Other Image Options

Binarization This is the process of converting a grayscale or color image to
a bi-tonal image. There are several different methods of
performing this conversion. Options: Dynamic
Threshold, Fixed Processing, Halftone 1~5, Error
Diffusion.

Dynamic Threshold: Selecting Dynamic Threshold
allows the scanner to dynamically evaluate each document to
determine the optimal threshold value to produce the highest
quality image. This is used to scan mixed document
containing faint text, shaded background, or color
background with a single setting. If Dynamic Threshold is
selected, Threshold, Brightness, and Contrast are not
available.

Dynamic Threshold (AD): Selecting Dynamic Threshold
(AD) to perform the enhanced mode of the Dynamic
Threshold feature. However, using this mode may slow down

your scanning speed.

Sensitivity of Dynamic Threshold

Occasionally your scanned image may contain small dots or
speckles. To remove these spots, increase the sensitivity
value by moving the bar to the right. The value ranges from
1 to 30. The default is 20.

Fixed Processing: Used for black-and-white and other high
contrast documents. A single level is set to determine the
black-and-white transition. The threshold is programmable over
the entire density range. Fixed Processing sets Contrast to 0.

If Fixed Processing is selected, Contrast is not available.

Halftone: In addition to the black and white display, Halftone
can present a somehow gray shade of image by using different
size of dots. Halftone image looks like the picture we have seen
in the newspaper. Options include Halftone 1, Halftone 2,

Halftone 3, Halftone 4, Halftone 5.
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Error Diffusion: Error Diffusion is a type of Halftone. Error
Diffusion gives good image texture and makes text in images

more readable than Halftone.
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Threshold

Used to convert a grayscale image to a

bi-tonal image. The value ranges from 0 to 255. A low threshold
value produces a lighter image, and can be used to subdue
backgrounds and subtle, unneeded information. A high threshold
value produces a darker image, and can be used to help pick up
faint images.

Adjust the threshold setting by dragging the Threshold sliding bar to
the left or right to achieve the desired threshold setting.

200 dpi, 200 dpi,
Threshold:50, Threshold:100,
Brightness: 0 Brightness: 0
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Gray

Document Type: Choice: Normal, Photo, Document

Three options of document type are provided when you choose Gray as the image
type for your scanned document. Choice: Normal, Photo, Document.

. Document: Choose Document if your original contains pure text or a mixture
of text and graphic since it is an optimal setting for regular business document.
When using Document, only Threshold can be adjusted.

. Photo: Choose Photo if your original contains photo to reproduce your photo in
vivid grayscale image. When using Photo, no Threshold and Contrast can be
adjusted.

o Normal: When using Normal, Threshold, Brightness, and Contrast can be
adjusted.

Threshold: The value ranges from 0 to 255. The default is 230. A low threshold
value produces a lighter image, and can be used to subdue backgrounds and subtle,
unneeded information. A high threshold value produces a darker image, and can be
used to help pick up faint images. Adjust the threshold setting by dragging the
Threshold sliding bar to the left or right to achieve the desired threshold setting.

Document
(Threshold: 230)

Normal Document

(Threshold: 230)
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Brightness

Contrast

Adjusts the lightness or darkness of an image. The higher the
value, the brighter the image. Drag the slider to the right or
left to increase or decrease the brightness. The range is

from -100 to +100.

Adjusts the range between the darkest and the lightest shades
in the image. The higher the contrast, the bigger the different
grayscale. Drag the slider to the right or left to increase or

decrease the contrast. The range is from -100 to +100.

Brightness: -50 Brightness: 0 Brightness: +50

(Normal)

Contrast: -50 Contrast: 0 Contrast: +50

(Normal)
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Resolution

A good control of the resolution results a good detail of
an image that scans. The resolution is measured by
dots per inch (dpi). Normally, the greater the dpi
number, the higher the resolution and the image file
size. Be aware that greater resolution takes more time
to scan, and more disk space for the scanning image.
For your information, an A4 size color image scanned at
300 dpi at True Color mode consumes approximately 25
MB of disk space. A higher resolution (usually means
over 600 dpi) is only recommended when you need to

scan a small area at True Color mode.

Choose a resolution value from the drop down list. The
default value is 200 dpi. Available resolutions are 75,
100, 150, 200,300, 400 and 600. Or you may choose
your desired value by clicking the box in the right side
of the drop down list and press the arrow key to select
your desired value and then click the Add button to
include it in the drop down list. Note: The resolution is
up to 300 dpi if an imprinter or a MICR reader is

installed or connected to the scanner.

Resolution: 75 dpi Resolution: 150 dpi
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Invert

Scan Source

Reverses the brightness and the colors in the image.
default setting is Black on a White background.

The

Reverse mode

is White on a Black background. For color images, each pixel

will be changed into its complementary color at the command

of Invert.

“E am not worthy to have you enter my

: that is God, I beg all my brothers - those w
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Black on White

White on Black

Choice:

« Auto Document Feeder:

Used to scan multiple pages.

+ Flatbed: Used to scan a single page. For example, pages

from newspaper clipping, paper with wrinkles or curls.

- Flatbed (book):
book.
« Automatic:

source.

Used to scan several inside pages from

Allow the scanner automatically set its scan

If Automatic is selected and there is document

in both the auto document feeder (ADF) and the flatbed,

then the scan source will be automatically set to ADF. If

Automatic is selected and there is document only in

flatbed, then the scan source will be set to flatbed.

+ Merge Two Sides into One Image:
If you have a sheet-fed duplex scanner with front input
tray, you can scan an A3 size document with an
innovative method. Thus, fold your A3 size document
into A4, and then load the paper in the front tray.
Choose Merge Two Sides from the Scan Source option and
then the scanner is able to scan both sides of your
document and merge two A4 images into one A3 image.

When you select Merge Two Sides into One Image, the

Cropping or Multi-feed function will be disabled.

Note: This feature must be used with a carrier sheet.

Regarding how to load a document with a Carrier Sheet,

refer to Section 4.6.2, Other Paper Selection.

Note the options vary based on type of scanner.
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If "Merge Two Sides into One Image” is selected, its choice will be available
including “"Merge Horizontally”, “*Merge Vertically”, “"Merge Vertically (Back
Side Flip)”. 1If the reverse side of your document is upside down, choose
“Merge Vertically (Back Side Flip)” and the back side will be automatically
rotated 180 degrees and merged.

Front
Side :
...................... Front Rear
Rear Side | Side
Side :
Merge Vertically Merge Horizontally

Note the options vary based on type of scanner.

Color The purpose of Color Matching is getting the accurate color. This
Matching option uses the default parameters (ICC profile) to adjust the
colors of the image.

Choice: None, Document, Photo
¢ None: Choose “"None” to disable this option.

e Document: Choose “"Document” if your original contains pure
text or a mixture of text and graphic since it is an optimal
setting for regular business document.

e Photo: Choose “Photo” if your original contains photo to
reproduce your photo in vivid color image.

Normal After Color Matching
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Scanning Color Images

The following options are available for scanning color images.

- Brightness

« Contrast
- Resolution
« Invert

Scanning Grayscale Images

The following options are available for scanning gray images.

« Brightness

« Contrast
« Resolution
« Invert

Scanning B&W Images

The following options are available for scanning B&W images.

- Binarization (Dynamic Threshold)
« Resolution

« Invert

Or

+ Binarization (Fix Processing)
« Threshold

- Brightness

« Resolution

« Invert
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Editing Profiles

The Scanner Properties dialog box allows you to change and save your frequently

used scan settings into a profile. You can edit these profiles by renaming or
deleting them.

To add a new profile,

1. Customize your settings. (For example, change your resolution, image type,
cropping method, scan size, or other scan settings.)
2. Click the Image tab and then choose “Profiles” to prompt the “Edit Your Profile”

dialog box.
[E=]
(Dmeme Thesnod )
e ;
Edit Your Profile ol o=
) Ao Bseion ) | Resouton @l s Profile: [Duplex, Bsw, 200 dpi = [ Add ] [ Delete ]
oG -
e Gockon Ve Rename.. | Reset |

7 Same setingsfr both s

Detats ok ) [ cencel ]

3. Click “Add” to enter the name of the profile and then choose “Save”.
Add A New Profile

Please enter the name of the profile:

[ Save J[ Cancel ]

4. The new profile will be saved and shown in the “Profiles” dropdown list box.

To load a profile,

1. From the Image tab dialog box, choose your favorable profile from the
“Profiles” dropdown list box.

Edit Your Profile = EoE 5
Profile: Duples, B, 200 dpi <] Add... ] [ Delete |
Duplex, Bi&Ww, 200 dpi
Duplex, Color, 200 dpi [ Rename... ] [ Reset ]

Duplex, Gray, 200 dpi
Simplex, B&&w, 200 dpi
Simplex, Color, 200 dpi
Simplex, Gray, 200 dpi

Exit

2. Your favorable profile will be immediately loaded and displayed on Scanner
Properties dialog box.
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To delete a profile,

1. From the Image tab dialog box, click “Profiles” to prompt the Edit Your Profile
dialog box.

Edit Your Profile [E=H ECE 5
Profile: [Fatbed - | Add.. ] [ Delste ]
[ Rename... ] [ Resst ]

2. Choose the profile you want to delete from the dropdown list box.

3. Click “Delete”. A Confirm message “Are you sure you want to delete this
profile?” is prompted.

4. Choose “Yes” to delete or “Cancel” to quit.

To rename a profile,

1. From the Image tab dialog box, click “Profiles” to prompt the Edit Your Profile

dialog box.
Edit Your Profile = e )

Profile: Betsy ~] | Add.. ] [ Delete ]
]

Duplex, B&&W, 200 dpi [ Rename..
Duplex, Colox, 200 dpi
Duplex, Gray, 200 dpt
Flatbed

Simplex, B&&W, 200 dpi
Stmplex, Colox, 200 dpi

R

2. Choose the profile you want to rename from the dropdown list box and then
click the Rename button.

3. Enter new name for the profile.

[ Rename a Profile ‘

Please enter the new name of the profile:

Original Name: Betsy

New Name:

[ Save ][ Cancel ]

4. Choose “Save” to save the new profile or “Cancel” to quit.

Note:

The preset default profiles include Flatbed, Simplex-B&W, 200 dpi, Simplex-Gray,
200 dpi, Simplex-Color, 200 dpi, Duplex-B&W, 200 dpi, Duplex-Gray, 200 dpi,
Duplex-Color, 200 dpi. If you have a simplex or a sheetfed scanner, the duplex or

the flatbed option will not be available.
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The Compression Tab

The Compression tab allows you to compress your scanned image and choose the
level of compression. Bi-tonal images are normally compressed using CCITT
standard called Group 4 (G4). Color and grayscale images are often compressed
using JPEG technology. Move the JPEG Quality slider to the right or left to
increase or decrease the level of compression. Note the greater the compression
level, the lower image quality. Default is 50%.

Note that the compression depends on your image editing application. If your
image editing application does not support the type of compression format, then
either a warning message will appear or the image quality of the compressed file
will not be acceptable.

JPEG (Joint Photographic Editor Group). This group developed and lent their name
to a file compression standard for color and grayscale images that is widely used by
scanners, and software applications. On Microsoft Windows-based systems, a file
with the extension .jpg has normally been compressed using this standard.

For scanning color or gray images, the following compressions are available:

«  None
« JPEG
For scanning B&W images, the following compressions are available:
«  None
- G4

Compression:
To complete your scan at a rated speed, the scanned image is compressed by
default during transmission. However, if you wish to obtain the highest image

quality, you can choose to uncompress the image data before it is output.

Scanned Scanned
Image Image
Image Editing
Scanner Scanner Driver g
Application
— —_

To Application:

Choose if you wish to compress the image data and transfer it from the TWAIN
driver to the application. Note Bi-tonal images are normally compressed using
CCITT standard called Group 4 (G4). Color and grayscale images are often
compressed using JPEG technology. Move the [Image Quality] slider to the right
or left to increase or decrease your image quality. Note the greater the image

quality, the lower the compression level. Default is 50%.

124



Note that the compression depends on your image editing application. If your
image editing application does not support the type of compression format, then

the image of the compressed file will look abnormal.

From Scanner: (Note: The availability of this feature varies due to scanner

model.)

Choose if you wish to compress the scanned image and transfer it from the
scanner to the TWAIN driver.

Choice: Uncompressed, *Best Image Quality (Low Compression Level), Better
Image Quality (Normal Compression Level), Normal Image Quality (High

Compression Level). (*: Factory Default)

H;; Scanner Properties @

Lmage | Compression |Paper ISetImg | Information
To Application

ront At Color Detection

ot Color Compression: [Ngm -

I T

ot Grray

ot BA: W

ear At Color Detection
ear Color

ear Crray

=l
iiii IIII

ear Biéa W

Ooooo

Fromm Scanner

Compression Mode: Best Image Quality -

o [coes

The Compression tab dialog box
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The Color Dropout Tab

Color Dropout Selection

The [Color Dropout] tab allows you to select either green, red, blue, or a color of
your choice to remove the details of the selected color from a scanned image. This
feature is used to sharpen your text when using OCR (Optical Character
Recognition) software. Note this feature applies only to the gray or black and white
image.

Choice: None, Auto, Remove Red, Remove Green, Remove Blue, Custom

- None: Does not remove any color.

- Auto: Automatically outputs the image with the details of the primary color
removed.

- Remove Red/Remove Green/Remove Blue: Outputs the image with the
details of the specified color removed.

- Custom: Specify the color you wish to remove by entering its RGB (Red, Green,
and Blue) value respectively.

Advanced Options:

- Quality Mode: Range: 0~20. Default: 10

When [Quality Mode] is selected, you can determine the color to be dropped out
using the [Filter Threshold] slider. A lower value will drop more of the selected
color out, while a higher value will leave more of the selected color in.

- Normal Mode: Use an optimized setting to determine the color.

ar_30 dayc after —_ sicnr ar_30 days after —_siGu!

(FIRST OF THE SAME TEN@R AND\DATE | (FIRST OF THE SAME TEN@R AND\DATE (

’\ I inchu Infernatio nchy, rnatio
yAn I THE SUM OF THE SUM OF

| 4
Original Auto/Remove Green (normal mode)
ar 30 doycafter  sicir ar_30 dayg after SIGHT
(FIRST OF THE SAME TENOR AND DATE (FIRST OF THE SAME TEN@R Al DATE
I Hsinchu Internatio nchu, rnatia
”; THE SUM OF THE SUM OF
C . I
Remove Red (normal mode) Remove Green (quality mode:

Threshold: 18)
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Preview the color dropout result:

To preview the color dropout result, please follow these steps:

1. Click the [Scanner Properties] icon (E) on the upper left corner, and
choose [Tab] to show available tab names.

2. Choose [Preview] to show the Preview tab.
Click the [Preview] tab to show the Preview page.

Load your document to the scanner and click the [Preview] button to get a
preview image.

5. On the [Image] tab, click [Gray] or [Black and White] image mode and then
choose [Custom] on the [Color Dropout] tab. A [Preview window] button will
be displayed.

6. Click the [Preview window] button to prompt the [Preview] window with
the previewed image.

7. Move your cursor over the preview image. Your mouse cursor now becomes
an Eyedropper.

8. Click to select a color which you wish to remove.

9. Click and hold your mouse button to view the result after removing the
specified color. If the result is satisfactory, click [OK] to close the Preview
window.

’7- Cromrei ] [0k ) i‘ Frovow ot Cox )
R:139.G: 130, B: 116 &] R:54.6:201. B: 1563

The Preview Window The Color dropout result
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é Scanner Properties
Color Dropout | Paper | Preview | Setting | Information |
Frontt Auto Color Detection Color Dropout: [None v]
Front Color Advanced Processing
Front B&W Filter Threshold | 10 < ’
7]
| |Rear 1uto:301p[ Daechop 4 184
Rear Color 134
B
[7] |Rear B&W
o ) [ o
The Color Dropout dialog box
To select a color on the Color palette,
) > Scanner [ E— ==
1. Click the Color Dropout tab from |/ G| cobmet [ |resen sos] Homsten
the Scanner Properties dialog e ET—
box. g
iy ; 184
B Blue: [ 184
B
B
> Scanner Properties =
2. Choose Gray or B&W from the [inee [ Corresin] Coor Dot | Papr | Prv [ Setig [ iomatin]
Custom v

Image Selection box and click
“Custom” from the Color Dropout
drop-down menu. The Color

palette appears.
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3.

4.

Move your cursor over the
palette. The cursor becomes a

Cross sign.

Image | Compression | Color Dropout | Paper [ Preview [ Setting | Information|

] [Frort ko Cotor Detecton | Gl Drpaut
Front Advanced Processing
= Heds Nomal
[E T T — [0
Red 82 [ g
| Green 193 [
Rear Color Blue: w2 = '
B
8

Click to choose a color. The RGB values are changed simultaneously.
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The Paper Tab

The Paper tab allows you to define values relating to image output (i.e., Auto Crop
or not, Scan Area, OverScan, Multi-Feed Detection).

> Scanner Properties
| Image | Compression l Color Dropout | Paper | Preview 1 Setting | Information |
Cropping: [Aulomatic S
["] Camier Sheet Mode
None
@ Portrait
Adjustment: Left: 0.00 = Top: 0.00 =
Right: 0.00 = Bottom: 0.00 =
Background Setting: [Whne Background v]
Unit: llnches V]
Feeding
Transport Timeout: < » 0 Seconds
Defaults { 0K ] { Cancel

The Paper tab dialog box
Cropping

Cropping allows you to capture a portion of the document being scanned.
Choice: Automatic, Automatic (36"), Fixed to Transport, EOP (End of
Page) Detection, Automatic Multiple, Relative to Documents.

Options Description

Automatic Automatic adjusts the cropping window according to
different document sizes and automatically straighten a
skewed document. Use this option for batches of
mixed-sized documents.

Automatic Automatically adjusts the cropping window according to

(36") different document sizes smaller than 36" and

automatically straighten a skewed image. Use this
option for batches of mixed-sized document.

Note: The availability of this feature varies due to
the scanner model.
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Fixed to

Transport

This feature allows you to define the area or zone to be
imaged. Use for batches of same-sized documents. If
you select this option, you can use the arrow keys to
define the x and y offset values, width and length to
redefine your scanned area. The Display window will
show image placement as you change the values.

EOP (End of
Page)
Detection

This feature allows you to define the area or zone to be
imaged. Use for batches of same-width but different
length documents. If you select this option, you can
use the arrow keys to define the x and y offset values,
width and length to redefine your scanned area. The
Display window will show image placement as you
change the values.

Automatic

Multiple

This option allows you to place various sized documents
such as photos, ID Cards, or business cards on the
flatbed (if available) and lets you create multiple
individually cropped images in one scan. Note: To
correctly create multiple images, please make sure
there is at least 12mm (0.5") of space between each
document.

Relative to

Document

This option allows you to crop different areas on your
documents and deliver these images in B&W, Gray, or
Color separately. For example, there are applications
which require you to store the entire document in B&W
and a part of the document in color to save storage
space. This is useful for documents where a
photograph or signature appears in a consistent area on
the document such as resumes, and so on.

The following options are only available when Fixed to Transport is selected.

X-Offset — the distance from the left end of the scanner to the left edge of
the scanning area.

Y-Offset — the position from the top end of the document to the top end of
the scanning area.

Width — the width of the scanning area.
Length — the length of the scanning area.

Center: automatically calculates the x-offset for center-fed feeding based
upon document size selected.

£
j—l — relocate the scan area by click the arrow key on the cross sign while
retain the scan size. View the result from the Display window.
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The Adjustment option is available when Automatic is selected.

+ Adjustment —adds a positive/negative margin value Top/Bottom or
toward left/right of the image. Adjustment is used when the automatic
document feeder is used. Adjustment reduces the possibility of corner
clipping on skewed images. To set Adjustment values, use the UP/Down
buttons to select where you want to apply Adjustment values: Top/Bottom
or Left/Right, and then select the amount of inches/mm/pixels applied.
Select a value within the range of 0.00 to 1.00 / -1.00.

Relative to Document: (used for batches of same-sized documents)

This option allows you to crop different areas on your documents and deliver
these images in B&W, Gray, or Color separately. For example, there are
applications which require you to store the entire document in B&W and a part
of the document in color to save storage space. This is useful for documents
where a photograph or signature appears in a consistent area on the document
such as resumes, and so on.

The following procedure describes how to reproduce the entire document in

B&W and a portion of document (picture) in color.

1. On the Paper tab, choose “Relative to Document” or “Fixed to Transport”
from the Cropping option.

2. Choose your scan size from the Scan Area option. The selected scan size
will be displayed in a red rectangular box. This is also the scan size of
your entire document. (For example, ISO B5. If you have not chosen a
scan area and leave the selection as None, then the default area will be
the scanner’s maximum.)

2> Scanner Properties (===
image | Paper | Preview | Setting | infomnation

Font Ak Colo Detoction s 1 23423753
[fonGie] o bbbl bl

[Front Gray ] 13
v [Foew__ 23

[Rear Color

[Rear Gray

[Reor BAW

A red rectangular box

Scan Area
JIS B5 - 182x 257 mm - =

XOffset 067
Y-Offset 000

Width: 717

Length 10.12

Unit [inches -

Selected area applies to all modes

Defaulls Prevew | [ ok | [ Cancel
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3.

Click the Preview tab to display the Preview window. A black rectangular

box appears to indicate the max. scan size your have just selected.

The Image
Selection
Box

4.

22 Scanner Properties

[mage

el —

[ fotGay ]

@ [FotBaw ]
=

[Rear Color

Scan Area:
150 A4 -210x 297 mm -
© Porrat Landscape

XOffset 012
Y-Offset oo
Width 827

Length 1169

Unit Inches =

[ Selected area apples to all modes

( Defaults

X}

123
23

143

Pevew | [0k ] [ Concel |

correctly crop your relative scan area.

2 Scanner Properties

- Font A Cor Defecion )
] (Front Color )
(G —)

) [Fomsaw

B o]
] RearCoor )

e T —
) ReaBaW__ )

Scan Area:

(180p4 2105297 =

© Potrat

Xt o
vore o
i =
et s
- = =)

7] Slected area applis to all modes

Defauits

[ | Conpressn | ot Dropos | Papr | Proven | Sating

Select image type from the Image Selection box.

A black
rectangular
box

Click the Preview button to view the entire image in low resolution to

The Preview
Image

The Preview
Button

The selected image will

appear in highlighted color. (For example, Front Color)

Place your cursor on the Preview window and click your left mouse button.

A cross sign will appear as illustrated. Create your relative scan size

diagonally by dragging the left mouse button to your preferable size.

The

selected area will appear in a red box as illustrated.

o 1

3 4 5 -] 7 8 a

P KXRTN KXREN KXRTN ERRRN KRRRN KRRRA KRUNEARRRARRTRA TN

s Scanner Properies

[ (Rear B8

Scan Area:

] Selected area applies to all modes

Defauls

image | Compression | Color Dropout | Paper | Preview

150 A4 -210x 297 mm -

~
XOffset 012
ok =
s

Preview oK Cancel

The
Relative
Area
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7. Check the B&W image from the Image Selection box to scan the entire
document.

8. Click the Scan button to start scanning the document in two image types
and sizes. (See the result in below.)

The entire document in B&W The relative area in color

Other Paper Selection

Carrier Sheet Mode:

Check this option to automatically crop the scan window according to your
document size when scanning non-standard document (fragile, irregular-size
document) with a carrier sheet (optional). Note: The availability of this option

varies due to scanner model.

Loading Documents Using a Carrier Sheet

A Carrier Sheet is a plastic sheet specifically used for loading non-standard
document onto the scanner. It allows you to scan document that can not be
scanned in the regular way. Also, documents larger than A4 size, such as A3 and
B4, can be scanned by folding in half, inserting into the Carrier Sheet, and
scanning in duplex mode. You can also scan documents that can be damaged quite
easily such as photographs, or irregular size documents that are difficult to load

directly such as clippings.
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To scan document using a Carrier Sheet,

For documents larger than A4/Letter size, such as A3

a. Fold the sheet to be scanned in half.
b. Fold the sheet tightly and smooth out crease. Otherwise, the sheet may be
skewed during scanning.

1. Open the Carrier Sheet and place the document inside.
Align the top of the document to the top of the Carrier Sheet (the printed area).

For documents larger than A4 /letter size, such as A3

Align the top of the document to the top of the Carrier Sheet (the printed section)
and the folded portion to the right edge of the Carrier Sheet so that the document
fits into the Carrier Sheet at the upper corner.

For non-standard document

Center your document in the Carrier Sheet.

2. Load the Carrier Sheet with the gray section (printed section) facing
downwards.

3. Adjust the paper guides to the width of the Carrier Sheet.
Adjust the paper guides so that there is no space between the guides and the
Carrier sheet. Space between the guides and Carrier Sheet may cause the
Carrier Sheet to become unaligned during scanning, and skew the scanned
image.

4, Start the scan.
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Notice:

° [Carrier Sheet] is available for the models that support the Carrier Sheet.
° Some functions are disabled when [Carrier Sheet] is checked.

° This option may not work properly on some applications.

Scan Area

Choose your desired paper size with the drop-down list box. Or you may
select a custom paper size by clicking the Scan Area box and then click Add
to include in the choice.

Choices are listed below:

None

US Letter- 8.5"x 11"

US Legal - 8.5” x 14"
ISO A4 - 21 x 29.7 cm
ISO A5 - 14.8 x 21 cm
ISO A6 - 10.5 x 14.8cm
ISO A7 -7.4x10/5cm
ISOB5 -17.6 x 25 cm
ISOB6 - 12.5x17.6 cm
ISO B7 - 8.8 x 12.5 cm
JIS B5 - 18.2 x 25.7 cm
JISB6 - 12.8 x 18.2 cm
JISB7 - 9.1 x12.8cm

Scanner Maximum
Long Page (<118")

Long Page (<118"):

When you need to scan documents whose length exceeds scanner maximum,
please choose Long Page. Note if Long Page is selected, the Multi-Feed
Detection will not be available. (Note: This option and the maximum

allowable document length vary due to type of scanner.)

When Long Page (<118") is selected, be sure to specify your document size
in the Length and Width field.
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Notice when scanning long page document:

1. Pull out the extension in the ADF Paper Tray.

2. Secure enough space around the Output Tray to prevent the ejected paper
from falling off the Output Tray.

3. To ensure the performance, in color mode, set the resolution to be 300 dpi or
lower; in Black and White mode, set the resolution to be 600 dpi or lower.

4. Depending on your system environments, application, or your specified paper
size, there may be insufficient memory to perform scanning.

OverScan

Overscan allows you to add a specific margin at top and bottom or right and left
(Options vary based on the type of scanner) of the edge of the image. This is
used to reduce possible corner clipping on the skewed images and often applied to
a batch of skewed document to be scanned in the auto document feeder. Select
a value between 0 and +5 mm. Note the overscan result will not be shown in
the Display window and that the availability of the function varies based on type
of scanner.

Pre-Feed

Choice: Enable, Disable. If enable is selected, you can set the amount of time
the scanner starts pre-feeding your paper after your documents has been loaded
into the feeder. The default is disable. Note: The availability of this option varies
due to scanner model.

Transport Timeout

Set the amount of time the scanner will wait and then start auto scan after the
first scan job is completed. If you have many separate documents need to be
scanned at the same scan settings, this feature is especially useful. The default is
0. The value ranges from 0 to 30 seconds.

Note:

1. Within the specified timeout period, if you load your document to the feeder,
the scanner starts scanning automatically.

2. If your scanner has a flatbed option and you place your paper on the flatbed,
after the timeout period, you need to click the Scan button on the TWAIN
user interface to start scanning.
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Background Setting This option allows you to set your scan
background. Choice: White Background, Black
Background.

Note: For a sheet-fed scanner with an auto

document feeder, this option is currently available
only in the “Auto crop” mode. For a scanner with a
flatbed platen, this option is available either in the

“Auto crop” or the “Fixed to Transport” mode.

White Background Black Background
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The Multi-Feed Detection Tab

Multi-Feed Detection

Multi-Feed Detection allows you to detect overlapped document that go through
the auto document feeder. Multi-Feed usually occurs due to stapled documents,
adhesives on documents, or electro-statically charged document. Note : The
availability of the function varies based on type of scanner.

> Scanner Properties
7Imaée”1’P;per Multi-Feed Detection :P;\;léwrl S;.ﬂl;g:l infc;rm;isn;”
Mutti-Feed Detection
Additional Length Detection
~] Utrasonic Detection
Unit: Inches v
( Defaults J [ 0K L Cancel

Additional Length Detection

Additional Length Detection allows you to define the length of document being
multi-fed. This value indicates the additional length exceeding your scan area.
The Display window will show the size of the document as you change the value.
A value of 0 indicates no additional length detection. The Additional Length
Detection is best used when scanning same-size documents in the auto document
feeder.

Ultrasonic Detection
Ultrasonic Detection allows you to set overlapped document by detecting paper
thickness between documents. Note : The availability of the function varies

based on type of scanner.

e Stop Scanning after Multi-Feed

- If this is not selected, the scanner will continue scanning the rest document
though multi-feed is detected. After the entire document has been scanned, a
multi-feed dialog box will be prompted to indicate the page humber which has
been detected multi-feed and need to be rescanned.

- If this is selected, the following options will be displayed.
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Stop: If this is selected, the scanner will stop scanning after a multi-feed is
detected. No further dialog box will be prompted.

Ask: If this is selected, the image of the page which has been detected
multi-feed will be displayed and three options are provided.

% Continue Scan: If the image of the multi-feed page is acceptable,

select [Continue Scan] to continue scanning the

rest pages.

= Continue
Scan(Discard
Image): acceptable, select [Continue Scan (Discard

If the image of the multi-feed page is not

Image)] to scan the rest pages yet the
multi-feed page will be ignored and you need to

rescan the page again.

> Stop Scan: The scanner stop scans. Remove the remaining

pages in the scanner. Remove staples or any
adhesive tapes on your document. Or fan your

document and rescan the rest pages.

e Multi-Feed Alarm

If a wave file is added, the scanner will make a sound alarm if multi-feed is
detected yet no Warning dialog box will be displayed.

How to add the sound alarm :

1. Click the Browse button on the right side of the speaker icon. The Open dialog
box appears.

2. Choose your wave file.
Click the Open button. The wave file is added.
Units

Defines the primary measurement system. Inches, Millimeters, and Pixels are
available.
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The Preview Tab

The Preview tab allows you to preview (a low-resolution scan) your image before
final scan. This preview image lets you allocate your scan area. You can choose
your scan area by the “Scan Area” drop down list box or placing your cursor on the
Display window and dragging it diagonally on the Display window. Then, a red
rectangle box will appear to indicate the selected area.

Note: If you choose “Automatic Cropping” on the “Paper Tab”, then to select a
scan area on the Preview tab is not allowed.

s> Scanner Properties @

Image [Compressqon lCoIor Dmpomﬁ] Faperj Preview 'Setting Information

o ]

E

Sl m—

:

Scan Area:

[150 A4- 210% 297 mm -
© Portrait an

The Display

XOffset: 0.12
Y-Offset: 0.00

Width 827

Length: 1169

[] Selected area applies to all modes

| Preview ‘[ 0K ][ Cancel

The Preview Tab
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The Enhancement Tab

The Enhancement tab allows you to set following additional image processing

settings.
2> Scanner Properties @
Image [ Paper l Mutti-Feed Detection l Prevlewr; Enhancement \ Semgg]
Punch Hole Removal
Background Setting
0
Edge Fill
@ White Edge Extend
|i| Black 0 Milimeters
Despeckle Line Removal
Noise Number: 0 =] Pixels @Jne v
Noise Radius: 1 [ Pixels 100
: Defaults 0K 1l Cancel A
The Option tab dialog box
Punch You can remove punch holes from the output scanned image when
Hole scanning punched document. Note the availability of this feature

Removal varies depending on your scanner model.

Original Output image

Punch holes can not be removed when:

Resolution is set lower than 150dpi

The hole is near the edge of the document

The holes are not aligned along the edge of the document
Punch Hole Removal is available only when “Auto Crop” is
enabled. If either “Fixed to Transport”, "EOP (End of Page)
Detection”, “"Automatic Multiple”, “Relative to Documents” is
selected from the Cropping option on the Paper tab, the Punch
Hole Removal option will be disabled.
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Shadow

Removal

When [Flatbed , on the "Scan Source; optionis
selected on the "Image  tab, the "Shadow Removal |

option will be enabled. Click to remove the shadow on

the book spine when scanning a book.

Y

“ | & — 2
Before Shadow After Shadow

Removal Removal
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Background Processing: The [Background Processing] option allows you to
smooth background color or remove it to make image clearer. The option is
especially useful for documents with color forms such as invoices.

Choices: None (default), Smooth, Removal

- None - no background processing will be performed (default)

- Smooth - produces images with a more uniform background color. This option
improves image quality.

- Removal - identifies the background color and then removes it.

Sensitivity: Choice: 0, 1, 2, 3, 4. Default: 0
- The higher the value, the more background color will be kept.

Mode: Auto, Moiré
If [Smooth] is selected in the [Background Processing] option, then the choices

for the [Mode] option includes Auto, and Moiré.
- Auto - uses the factory preprogrammed mode to proceed background smoothing.
- Moiré — Remove the moiré patterns that appear on the background of the image
when scanning printed material.

If [Removal] is selected in the [Background Processing] option, then the [Mode]

option will be replaced with [Fill Color]. Choices: White, Auto.
- White - identifies the background color and substitutes it with white.
- Auto - identifies the background color and substitutes it with the color of the

largest background zone.
FedEx
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Background Processing: Background Processing:
Smooth Removal
Fill Color: White
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Note: Background color in small zone will not be processed or removed.

Edge Fill Check White or Black if you wish to add white or black
edge on the border of your scanned image. Enter the

value from 0 to 5 mm. Default value is 0.

Original Edge Fill: 5mm
(Black)

If you want to add a white or black frame on the edges

of the scanned image, check "Edge Extension".

The default value is 0. The maximum value is half of the
short side of the selected scan area.

For example, if you choose an A4 size (8.26 "X11.69"),
then the maximum value of the white or black box is
4.14" (half of "8.26").
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Despeckle

Occasionally small dots or specks appear in the background of a scanned image.
Remove unwanted speckles provides a cleaner image for OCR (Optical
Character Recognition) processing, and also helps to reduce compressed file

size.

Define the speckles (also known as image noise) you wish to remove by
specifying its number (size) and radius (range). The measuring unit is pixel.

The higher the number, the more speckles will be removed.

. %plague on thee! Hast thou
%plague on thee! Hast thou never an eye in thy head? Canst
never an eye in thy head? Canst not hear!?
not hear? . . —The First Part of King Henry the Fourth:
—The First Part of King Henry the Fourth: 2.1.26-27
2.1.26-27
A carrier to Gadshill, the host of a tavern.
A carrier to Gadshill, the host of a tavern.
Before Despeckle After Despeckle
(noise number:0, noise (noise number:22, noise
radius:1) radius:10)
Note:

e The function is currently available for Black and White image only.
e To scan at rated speed, it is recommended to set the noise radius up to 10

pixels.
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Line Removal: When Black and White image mode is selected on the
[Image] tab, the [Line Removal] option will be enabled. Line Removal
erases lines on the image and then reconstructs characters so the OCR
(Optical Character Recognition) accuracy can be improved.

Choices: None, Form, Horizontal, Vertical
None - the default mode which does not remove any line.

Form - remove any form in the document.

Horizontal - select [Horizontal] and then enter the length of horizontal

line to remove only the horizontal line exceeding your specified length.

Vertical - select [Vertical] and then enter the length of vertical line to

remove only the vertical line exceeding your specified length.

Adin :Hir. Danid Wang

Adin :ir. Daid Wang.
Shigped by SST Tedhmalogies I
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The Rotation Tab

The Rotation tab allows you to set the following image rotating options:

.z Scanner Properties

Rotation

Rotation Degrees :

Image Control Options

Split Image:

Flip Side Rotation

Image Control Options

] Mimor

Book

i Image | Paper [VMulti-Feed Detection ! Previewr‘ Rotation LEnhancement [ Setting [ Information |

INone

5

lNone

z)

Defaults

0K I l Cancel

Rotate Image

Choose the rotation angle from the drop down list if

you wish to rotate your scanned image.

Choice: None, 90°CW/(clockwise),
90°CCW(counter clockwise), 180°, Auto based

on contents. Auto rotate every even page.

[E—

123 ~
o

Original Rotate 90°CW

o

% CE I

—

Rotate 90°CCW

Rotate 180°
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Auto based on contents: Automatically rotate
images based on the contents of document. When
" Auto based on contents | is selected, its modes

will be enabled to let you select more options.
Mode: Quick, Full Text, Complexity

Quick - the default mode to let you rotate images at

the fastest speed.

Full Text - the enhanced mode for documents with

mixed text orientation.

Complexity - the enhanced mode yet at the slowest
speed for document with complex image or text

orientation.

Auto rotate every even page:

Automatically rotate 180° on every even page. This
is especially useful when you scan the inside pages
from a book. As a result, if you choose “Flatbed
(book)” from the “Scan Source” option, “auto rotate

every even page” will be selected as default.

Note: This option varies based on type of
scanner.

wossr Sag or

 o¥06IIN

‘ 4 ) \L)
Document with various Document with dark
text orientations or complex
background
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Split Image By splitting an image, two separate images are
created horizontally or vertically. This is useful for
documents containing two pages per image when
you want to save them as two images (one page for
one image). Choice: None, Horizontal, Vertical.

Default is None.

Horizontal: Divide one image into the upper half

and the lower half.

Vertical: Divide one image into the left half and the
right half.

* I

Split Horizontally Split Vertical
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Flip Side
Rotation

Select “fanfold” to rotate the image of the reverse

side to 180 degrees.

This is applied to double-sided document which are
viewed in portrait are sometime fed into the scanner

in landscape or vice versa.
Choice: Book, Fanfold.

If "Book” is selected, the image of the reverse side

will not be rotated.

The following illustration shows the documents
which should be viewed in portrait are fed into the

scanner in landscape
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Image Control Check the Mirror box if you wish to reverse the right

Option and left side of your image.

Original The Mirror Effect
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The Separation Tab

The Separation tab allows you to enable the detection engine to detect the blank
page, barcode, and patch code and then notify the software application which
supports document separation to separate your multi-page documents. Choices:
Blank Page Removal, Barcode Detection, Patch Code Detection.

.5 Scanner Properties
Image I Paper l Multi-Feed Detection l Preview l Rotation | Separation | Enhancement I VSeﬂingrl Information
Blank Page Removal
7| Blank Page Removal Threshold
Barcode Detection
Enable
Patch code Detection
|| Enable
Defaults OK | Cancel :
Blank Page Choices: None, Blank Page Removal Threshold,
Removal Image Size.

None - Do not remove the blank pages.

Threshold - Move the slider to the left or right to
define your threshold for the blank page.

Image Size - Range: 1~ 10000 KB. Specify your
desired image size to detect the page as a blank
page. For example, if 3 KB is selected, any page less

than 3 KB will be recognized as blank page.

Barcode Check [Enable] to detect barcode and notify the
Detection software application for advanced processing. Please
note the whole document will be checked and no

specific detection area needs to be designated.
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When the bar code has been detected successfully - a file [avbarcode.ini] will be

created and stored in the following path:

Windows XP: C:\Documents and Settings\All Users\Application
Data\%PRODUCTNAME%

Vista, Windows 7, Windows 8, Windows 10: C:\ProgramData\%PRODUCTNAME%

Barcode Types:

The following barcode types can be detected.

Two-dimensional codes
° Aztec

° DataMatrix

° PDF417

° QR Code

One-dimensional barcodes:
Add-2

Add-5

Australian Post 4-State
BCD Matrix
Codabar

Code 128

Code 32

Code 39

Code 93

Datalogic 2 of 5
EAN 128

EAN-13

EAN-8

GS1 DataBar
Industrial 2 of 5
Intelligent Mail
Interleaved 2 of 5
Inverted 2 of 5
IATA 2 of 5

Matrix 2 of 5
PostNet

Royal Post 4-State
UPC-A

UPC-E

Barcode Zone:
Specify the barcode zone to be detected.

Select "TAll ; to checks the whole document and detects barcodes. Or you may speed
up the process by specifying a detection area since only the specified area is checked.

Choice: All, Top, Bottom, Left, Right, Bottom Right, Bottom Left, Top Right,
Top Left
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ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Aztec.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/DataMatrix.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Australian%20Post%204-State%20Barcode.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/BCD%20Matrix.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Codabar.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Code%2032.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Code%2039.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Code%2093.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/DataLogic%202%20of%205.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/EAN-8.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/EAN-8.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/EAN-8.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/GS1%20DataBar.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Industry%202%20of%205%20(Industrial%202%20of%205).html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Intelligent%20Mail.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Interleaved%202%20of%205.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Inverted%202%20of%205.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Matrix%202%20of%205.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/PostNet.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Royal%20Post%204-State%20Barcode.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/UPC-A.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/UPC-E.html

Choice for barcode zone on a page:

All Top Bottom Left Right

Bottom Bottom Top Right | Top Left

Right Left
Note:
e Recommended resolution: 200~600 dpi for regular barcode, 300~600 dpi for
QR code

e Skewed barcodes may not be recognized correctly.

e Using the same sheet repeatedly may decrease the recognition accuracy due to
accumulated dirt on the sheets. If the sheet is not recognized correctly or gets
smudged, replace it with a new sheet.

Patch code Detection:
Check [Enable] to detect patch codes and notify the software application for
advanced processing.

A patch code is a pattern of parallel, alternating black bars and spaces (i.e. a
barcode) that is printed on a document. Patch code sheet is most commonly used
as a document separator in a stack of document.

You can find various sizes of patch codes (PDF) by choosing
[Start] menu>[All Programs]>[Avision Scanner Series]>[Patch code] in
succession.

Simply print the PDF file to produce the patch code sheet. Insert the patch code
sheets to wherever you want the file to separate.

Patch code sheet
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Notes to print the patch codes:

Use blank white paper.

Set the scaling to 100%. The sheet is not recognized correctly when printed in
a size smaller than the original.

Do not use toner saving mode. The sheet is not recognized correctly when the
print is too light.

Do not use thin paper in order to avoid bleed-through from the back.

When you copy a patch code sheet that you printed out, make sure to copy by
the same size and brightness as the original copy.

Use the same sheet repeatedly may decrease the recognition accuracy due to
accumulated dirt on the sheets. If the sheet is not recognized correctly or gets
smudged, replace it with a new sheet.
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The Setting Tab

The Setting tab allows you to set the following settings:

23 Scanner Properties =
[image | Paper | Setting | infomation |

Cache

Hode (Menoysee ]

Memory Size: < »  Default

Energy Saving Conrol

Enable Energy Saver ‘ + 15minutes

7=y

Bia] (7] Enable Power OF < ' 240minutes

7| Show Scanning Progress Tabs

p— ] Compression

V| v W M

/] Show Waming Message ] Colr Dropout
] Muti-Feed Detection
] Preview
[] Rotation
] Separation
[] Enhancement
] Imprinter

Defaults 0K

The Setting tab dialog box

Energy
Saving

Control

Check the Enable Energy Saver box and move the slider to
set the amount of time to start the energy saver after your

last action. The range is from 1 to 60 minutes.

Enable Power
Off

Check the Enable Power Off box and move the slider to set
the amount of time to automatically turn off the scanner after
your last action. The range is from 1 to 480 minutes. The
default is 240 minutes (4 hours). Note the value of “Power

Off” has to be greater than or equal to the value of “Energy

Saving”.

157




Cache

Mode: None, Page Number, Memory Size.

This option allows you to assign a specified memory
size from the available RAM to process the image
data. By specifying a smaller memory size, you can
free more memory for other applications you are
running. By specifying a larger memory size, you can
have more memory to process the image data
especially when you have a large amount of

documents needed to be scanned.

You can also specify your memory size by the page
number. For your information, an A4 color document

scanning at 300 dpi consumes approximates 24MB.

Image Count

When the selected cache mode is "none”, the image
count option allows you to assign number of pages
you need to scan. For example, if you wish to scan the
first two pages, simply move the page slider to 2, and
the scan action will be stopped when the scanning of

the first two pages have been completed.

Show Check and the scanning progress bar will be shown
Scanning during scanning.

Progress

Show Check to show the warning messages such as “ADF
Warning pad count exceeds 50,000 scans (the number varies
Message based on type of scanner). Please replace the ADF pad

and reset the pad count.”

Save Settings
after Closing

Check to save your scanner properties settings after
leaving the dialog box. Next time when you open the
Scanner Properties dialog box, the previously saved

settings will be shown.
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The Imprinter Tab

The Imprinter tab allows you to print alphanumeric characters, date, time,
document count and custom message on your scanned image if digital imprinter is

selected or at the back of your document if external imprinter is selected.

.5 Scanner Properties

7ImagreVIVPVaper [ Sreningi Imprinter Irﬂbrmatnon‘

Digttal Imprinter

Content

Advanced Print Position

Sample

0o01

| Defauts | T]ﬁ

Choice: External Imprinter, Digital Imprinter. If you have installed an
external imprinter, choose external imprinter. If you do not have an imprinter,
choose digital imprinter. Note External Imprinter provides a vertical and rear-side
print capability while digital printer provides a horizontal and front-side print
capability.
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Contents

Print All Check Print All to automatically print the text at all
pages of your documents.
Uncheck Print All to print the text for the first page of
your documents only.

Custom Enter your custom text to be included in your print
string.

Counter Show the document count for the scan session. This
value is increased sequentially by the scanner.

Date/Time Choose if you wish to include the date and time in

your print string.

Format: YYYYMMDDHHSS For example,
20090402170645-check0001 indicates year, month,
date, hour, seconds, your custom text and the

counter.

Custom Font

Choose your desired font.

Choice: Normal, Fixed Width

Fixed Width (Mono spaced) fonts have a fixed
character spacing. So each character occupies the

same width.
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Advanced

Font Attributes

Choose your font attributes. Choice: Normal,
Underline, Double, and Bold.

String

Orientation

Choose your string orientation.
Choice: Normal, Rotated, Vertical, Vertical
Inversion, 90 degrees CW, 90 degrees CCW

2010abc 9qe010c

Normal Rotated

O LVO—=0ON
NO—O @O

Vertical Vertical Inversion

2qeQl0c¢
2010abc

90 degrees CW 90 degrees CCW
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Print Position Choose the position you wish to print your string.
Move the slider to the right to increase the value or to
the left to decrease the value. Range: 0~355mm,
default:0 mm

The value indicates the height from the bottom of your
paper to the last letter of your string. This option is

available only if an external imprinter is installed.

The value of
| Print Position

<+«—»0T10¢ 291000

Print Position (for digital imprinter)
Choose the position of your printed string. Choice: Top, Middle, Bottom,
Custom. If Custom is selected, enter the X and Y offset value to specify the

position.

More: Click the [More] button to display more font options. This option is
available for digital imprinter (stamp text on your scanned image) only. This

function is not available on some models.

Font size: Move the slider to change the font size from 1 to 10. Density: Move
the slider to change the source density from 0 to 255. The selected density will

appear at the same time.

Transparency: Move the slider to choose an appropriate transparency value
from 0% (not transparent) to 100% (completely transparent) so that your text

can be partially transparent and you can see the background image.
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The Information Tab

The Information tab displays the following system and scanner information.

=2 Scanner Properties

Image { Paper i Setting I Imprinter : Information |
CPU: intei(R) Core (T} 13-2120 CPU @ 3 30GHz R
RAM: 1023 MB
0S: Microsoft Windows 7 Enterprise Service Pack 1 (Build 7601)
0S Language English (United States)
Disk Drive: Fixed drive C:\Total:30717MBFree:10433MB

Fixed drive Y:\Total:102398MBFree:10541MB =

Fixed drive Z:\Total:102398MBFree:23311MB
Free Disk Space: 10439 MB
Application Name: Avision Capture Tool 1.6 (1.9)
TWAIN Driver Version: 6.11.0329'16
1/0 Driver Version: 0.9.2016,324
Port Type: usB
1D / Address: usB
Optical Resolution: 600 dpi
Scanner Model: o
Serial Number: NO25 i

Report... ;]
Cancel

The Information tab dialog box

The “"Report” button :

If you encounter any error message while using the scanner, click the Report
button. A report.txt file [Windows XP: C:\Documents and Settings\All
Users\Application Data\%PRODUCTNAME®%; Vista, Windows 7, Windows 8,
Windows 10: C:\ProgramData\%PRODUCTNAME% (C: system drive)] will be
generated. Please send this file to the nearest service center for trouble shooting.

The “"Reset Roller Count” button :

After scanning over a recommended number of pages (refer to subsequent section
7.4 Replacing the ADF Roller) through the ADF, the ADF roller may be worn out
and you may experience problems with document feeding. In this case, it is
highly recommended to replace the ADF roller with a new one. (Note the
replacement of the ADF roller has to be performed only by authorized service
center. Therefore, please return your scanner for roller replacement.) After
replacing the ADF roller, click the "Reset Roller Count” button to reset the roller
count.

Note :
The lifetime and the replacing procedure vary based on type of scanner.
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9 ISIS Interface Operation

* Please refer to the preceding chapter, Scanner Installation, to install ISIS scanner driver.

You may start your ISIS-compliant software application to scan via the ISIS user interface.

The ISIS driver operation method is similar to the TWAIN’s. Every function on the ISIS

interface screen is briefly described as below:

Scanner Settings

| Black and white ~] | @ Manual c
Dife: By | O | b |
Halftone 4 40 Cancel
= Darken | Norm | Lighten I
Dots per inch: o
J300 ~ A&
Page Size: Contrast
[a5-148%21.0cm ~] | ® Manual c
PIXDFLT Version 55.1.260.851 BN R S = [ P
Avision PXN Driver ¥2.01.062402

Mode: Select one of scan modes, including B&W, gray, color options.

Dither: 5 halftone levels available, can be disabled.

Dots per inch: Select your desired resolution.

Paper Size: Select your desired paper size.

Brightness: Adjust your scan image brightness or darkness.

Contrast: Adjust the range between the darkest and the lightest shades in the image.
Default: Click to reset all settings.

Area: Select your desired scan area or position.
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10 Scanning and Sending the
Scanned Images to Your
Computer (BM2 Air)

Before You Begin:

Before you begin using the function of [BM2 Air], please make sure you have
already installed the scanner driver, Button Manager V2, and connecting to the
scanner to your computer via a USB cable or an ethernet cable as described in
the preceding section, chapter 7 Using the Product as a Regular Scanner.

E )

USB Connection LAN Connection

Installing Button Manager V2

Button Manager V2 provides you an easy way to scan your document and then

link the scanned image to your designated software application. All this can be
done by a simple touch of the button on the scanner. Yet, before you scan, it is
recommended to check the button configurations first to ensure a proper file

format and a destination application.
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Checking the Button Configurations before Scanning

1. Button Manager V2 runs from the system tray. After Button Manager V2 and
the scanner driver are properly installed, Button Manager V2 is started and
the Button icon will be displayed on the system tray at the bottom right
corner of your computer screen.

&32 OLALPM

2. Left-click the Button Manager V2 icon to prompt the following Button Panel.

/ This indicates the scanner model

A 1
[.5] 18can (Image)
r.t:“f !
[.5] 18can (OCR)
1 —  The Function
§ ScanTodpp
Icon
I 5 E-Mail (The Inunjber of
function icons
I{:}P Printer _ | vary based on
- type of
= = scanner.)

£ Ty 5 @ B 1145

T

The Button
The Button Panel

166



3. The Button Panel shows the first five scanning buttons. Right-click the
button (function) you wish to check. The Button Properties window appears.

Name of the Selected Button

Button Properties - iScan (OCR)

Button Besic | Image Adjustment | Color Dropout | Image Processing | More Settings|
‘Scan Peremete
Name B iscan (ocR) TR =~
e Resolution(dpi): ] [300 |
mage Mode
Image Mode [m O Auto Paper Size: :AutoCmp&Deskew v
Selection )
5 [ Ocolor DI Duplex Basic Scan
0X ©Tmy
{.], O Black sl Whit Advanced Settings: [ Use TWAIN Setup Parameters
A
Folder and b Loveten
file name for Disscory:  [CADeocumentsand Sefingshoid My DocumentiMy Pichues| [_Biows ]
the scanned File Neme: Tmage_##### ]
image - - =
9 File Format: | OCR (For iScan Only) v/
Destination: ‘ 5 iScan D ‘
Scan To — Description: [ O};en your application, scan and mserl the scanned umge or editable text
destination (after OCR) directly to your application.

and settings

OCR Language: |Chinese Tradiionsl | Scan Count: 0

OCR OCR Zone: Nons Keyword: |
settings No. of Recognized Characters After Keyword: ‘ ‘

If you wish to change the setting, use this window to reset the setting for the file

format, destination application, or other scan settings.

4. Click the OK button to leave the window.
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Scanning From One Touch of the Buttons

1. Adjust the paper guide for the width of paper and load the document with
their tops into the automatic document feeder.

2. Use V¥ to scroll down to [BM2 Air] on the LCD display.

3. Check the button (function) number on the LCD screen to ensure if you are
selecting the proper scan settings and destination application. (For example,
if you wish to scan with button (function) 3, “Scan to App”, which opens
Microsoft Paint and displays the scanned image in the window of Microsoft
Paint, the LCD screen should show “Function 3").

4. Press the Scan button on the scanner.

5. After the scanning is finished, the Microsoft Paint software will be launched
and the scanned image appears in the main window of Microsoft Paint as
below.

.; n General Document feeding mode Flatbed 3

Z4Q Technology

'i : Optical resolution

N Scanning speed

(=13 RAM

ot ADF min. paper size 4.5 inch
ADF max. paper size 8.5 inct
Flatbed max. paper size 8.5 inch
ADF capacity
Operation environment 10
Storage environment -2C
Noise
Dimensions(H x W x D)
Weight

Copy First copy out Color modt
Specifications: Color copy speed

B/W copy speed
Copy resolution |
Copy scaling
Multiple copies

" FF(IFEPEHFFFEHF

Note:

For details information on how to use the Button Manager V2, please refer to the
user’'s manual in the supplied CD.
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11 Troubleshooting

Clearing Paper Jams

In the event of a paper jam, follow the procedures below to remove the paper:

1. Press the ADF Release Button on the right side. Gently open the Scanner
Front Door to the left.

2. Carefully pull the paper out of the ADF unit.

3. Close the scanner front door. Your Scanner is now ready to use.
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Questions and Answers

Question: Paper becomes jammed during scanning.
Answer: 1. Open the front door.
2. Pull out the jammed paper carefully.
3. Close the front door.
Question: More than one sheet of paper are fed into the scanner.
Answer: 1. Open the scanner front door.
2. Remove the multi-fed sheets.
3. Close the front door.
4. Flatten the corners and edges. Loosen the paper before
putting it into the paper guide again.
5. Check the feeding roller condition. If necessary, follow
the cleaning directions and perform the cleaning.
Question: Paper becomes skewed in the scanner.
Answer: 1. Use the slide guide to keep the paper path straight.
2. Check the condition of the feeding roller. If necessary,
follow the cleaning directions and perform the cleaning.
Question: Why does my scanned image always come out too
dark?
Answer: 1. Please adjust the screen settings to SRGB.

2. Please adjust the brightness settings on the screen from
application software.
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Errors Indicated on the Touch Screen

Error Code and Error Messages

Error code

Problem Description

Network Errors

Solution

592301

Mail server is not set.

1.Check “Mail server” setting.
2.Contact your your network

administrator for further help.

592302

DNS server is not set.

1.Check “"DNS server” setting.
2.Contact your network administrator

for further help

592303

Failed to convert Computer

Name to IP.

1.Check “"DNS server” setting

2.Check target server name and domain
in CIFS URL.

3.Check Client for Micrsoft Networks on
PC side.

4.Contact your network administrator

for further help

592304

Failed to get IP address from

DNS server.

1.Check “DNS server” setting
2.Check target server name.
3.Contact your network administrator

for further help.

592305

NTP Errors

Detected an IP address

conflict.

1. Check network settings.
2. Contact your network administrator

for further help.

593001

NTP server does not respond

within the timeout period.

1.Check “NTP server” setting.
2.Check firewall settings.

3.Check network environment.
4.Contact your network administrator

for further help
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LDAP Errors

LDAP URL is empty.

596001 Enter LDAP server IP or Port.
Failed to connect to LDAP
596002 Check LDAP server IP or Port.
server.
596003 Authentication type error. Check the authentication type.
LDAP account or password is
596004 Enter login name and password.
empty.
Please check login name and
596005 Check login name and password.
password.
596006 Search root is empty. Enter "search root".
596007 Failed to search. Check "search root".
596008 Search attribute is empty. Enter "search attribute".
Wi-Fi Errors
Failed to connect to Wi-Fi AP.|check password if Wi-Fi AP (Access
597001
Point) requires password.
Scanner fails to scan in AP mode. Try
597002 Failed to initiate AP scan. later. If this problem always exists,
contact your nearest dealer.
Scanner does not search any Wi-Fi
AP.
597003 Unable to find a wireless AP.

Try again later. If this problem always

exists, contact your nearest dealer.
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SMTP Errors

530002 Failed to connect to Mail 1. Check Mail server address and port
server. number.
2. Check network environment.
3. Contact your network administrator
for further help
530003 Failed to connect to Mail Contact your network administrator
server via SSL. about Mail server settings. Set correct
Authentication method and Encrypt.
530004 Failed to connect to Mail 1.Contact your network administrator
server because server about Mail server settings.
requires SSL connection. 2.Set correct authentication method
and encrypt.
3.Change encrypt setting to SSL and
try again.
531011 Mail server requires 1.Contact your network administrator
TLS/STARTTLS connection. |about Mail server settings.
2.Set correct authentication method
and encrypt.
3.Change encrypt setting to
TLS/STARTTLS and try again.
531012 Scanner tries to do 1.Contact your network administrator
authentication, but mail about Mail server settings.
server does not require it. 2.Set correct authentication method.
3.Change authentication method to
None and try again.
531013 Authentication method Contact your network administrator.
replied by Mail server is not
supported on this scanner.
538001 Connection is broken during |1. Check network environment.

data transmission.

2. Check if email attachment size is

larger than the mailbox quota.
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530421 Mail server replies that |Contact your network administrator for

531421 service is not available. |further help.

532421

533421

534421

536421

537550 Login name must be the |The account of from and login must be
same as From address. |same

533450 Recipient mailbox may |Check “To” addresses.
be not available.

532451 Requested action is Contact your network administrator for

533451 aborted by Mail server. |further help.

534451

535451

537451

533452 One recipient's mailbox |1.Check recipient mailbox quota.

535452 has insufficient storage. |2.Contact your network administrator for

537452 further help.

530500 Failed to connect to Mail |1.Contact your network administrator
server via about Mail server settings.
TLS/STARTTLS. 2.Set correct authentication method and

encrypt.
3.Change encrypt setting to None and try
again.

532530 Mail server requires to  |Contact your network administrator about

do authentication.

Mail server settings, authentication

method and encrypt setting.
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531534 Mail server rejects your 1.If you are using Gmail as mail server,
login. please turn on "Access for less secure
apps". Or enabling 2-Step Verification and
then create an "app password" for
scanner.
2.If you are using Gmail as mail server,
you can login on A place, at the same
time, someone uses your account to login
on B place. Gmail will reject someone's
login.
3. Please contact the administrator of mail
server.
531535 Failed to login to Mail server.|{ gerver requires authentication.
2.Check login name and password.
533001 To, CC and BCC addresses
Enter email address.
are empty.
533550 Recipient mailbox may be 1. Check recipient’s addresses.
not available. 2. If mail server is Microsoft Exchange,
please check the settings on mail server,
is the IP of machine allowed to send mail?
535552 Mail attachment size 1. Check mailbox storage allocation.
537552 exceeds Mail server's
limitation.
533553 Recipient address is not Check "To"” addresses.
correct.
532440 From address is not correct. |[Check “From” address.
532553
532554
537554
532501 From address is invalid. Check “From” address.
533504 HELO command is rejected. |Check "Host Name" and "domain name".
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FTP Errors

Failed to connect to FTP

Make sure the FTP server has not been

540002 |server. shut down and port number is correct. If
firewall is enabled, check firewall settings.
Failed to connect to FTP Make sure the FTP server has not been
server via SSL. shut down and port number is correct.
540003 If the error is still there, contact your your
network administrator or FTP server
administrator.
Failed to login to FTP server.
540004 Check your login name and try again.
Failed to login to FTP server.
540005 Check your password and try again.
FTP control connection is 1.Contact your network administrator to
540020 broken. check FTP server log.
540021 2.Contact your network administrator to
check network environment.
FTP server does not open 1.Contact your network administrator to
data connection to scanner. |check firewall settings.
2.Contact server administrator to check
540023
ftp server log.
3.Change Active mode to Passive mode
and try again.
Data connection is broken 1.Contact server administrator to check
546005 during transmission. server log.
2.Check network environment.
Failed to open passive mode |1.Contact your network administrator to
data connection to FTP check firewall settings.
549002
server. 2.Contact your network administrator to
check FTP server log.
. Too many connections from this IP,
FTP server replies that contact your FTP server administrator.
service is not available and it|2- FTP server shut down and cannot
provide services.
540421  |closes control connection.  |3. Try again later. If problem persists,

contact FTP server administrator.
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Failed to open data

Contact your network administrator to

546425
connection to FTP server. check firewall settings and FTP server log.
544450 Failed to access file because |The file already exists and is locked by
546450 it's locked on server. Windows. Check your network
548450 administrator.
Insufficient storage space in |Ask server administrator to increase
546452
FTP server. allocated storage space, or delete
548452
unnecessary files.
Failed to access target 1.Check if the directory exists or not.
540550 directory or directory has 2.Check if the directory is empty or not.
being deleted.
Failed to write file to FTP 1.Confirm that you are attempting to
server. connect to the correct server/location.
541550
2.The administrator of the remote server
542550
must provide you with permissions to
546550
access files via FTP.
3.Check if file has not being opened.
Server does not support Please enable "passive mode" and try
543421 active mode. again.
Filename is not allowed on |Change the file hame or delete
46553 FTP server. Please check spaces/special characters in the file name.
48553 filename.
CIFS Errors
Account is locked. Please
Contact your your network administrator
560029 | contact your network
for further help.
administrator.
Failed to login to target
560033 Check domain in Network settings.
PC.
The trust relationship
between this workstation Contact your your network administrator
560034
and the primary domain for further help.
failed
. 1. Check the network cable or
Target PC's IP address is connector.
not correct. 2. Check if URL or IP address is correct.
561003 3. Check if "File and Printer Sharing for

Microsoft Networks" is enabled.
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Access is denied from

Please check access permissions of

561005
target PC. shared folder on target PC.
File is closed during
561006 Please check target PC.
communications.
Sharing violation or
Please check if shared folder name is
561032 | file is in use on target
correct.
PC.
Shared folder does
562005 not exist during Please check target PC.
transmission.
Shared folder name Please check profile settings and shared
562006
is not correct. folder name on target PC.
Target PC does not
Server busy, and try scan-to CIFS again
562088 respond within the
later.
timeout period.
Target PC replies 1. Please wait CIFS service initialization,
service is not ready. and try scan-to CIFS again later.
563021
2.Please check the same hostname on
different machines.
Insufficient disk
563039 Please clean up disk space.
space on target PC.
Connection is broken
Check the network cable or connector.
569001 during
Check if URL or IP address is correct.
communication.
Shared path is not
Please check if URL or IP address is
correct. No shared
569033 correct.
folder in the URL.
Target PC does not
Server busy, please try scan-to CIFS
569020 respond within the

timeout period.

again later.
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SharePoint Errors

Server errorRequest Please check if the login information
parameter error. such as user name, password, server IP,
555400 Domain, location URL, or subfolder is
correct and check also the network
connection status.
Please check if the login information
Server error : Login failed. such as user name, password, server IP,
555401 Domain, or location URL is correct and
check also the network connection
status.
Please inform the server administrator
Attachment exceeds to change the max. upload file size. And
555402
limitation. please check the settings with your
server administrator.
HTTP Errors
550002 Failed to receive data. Check network environment.
550004 Data length is wrong. Please try again.
556001  |HTTPserver URLisinvalid. |check the format of URL.
Failed to connect to HTTP
1.Check the server name or IP in URL
556002 server.
2.Check network environment.
Connection is broken and fail |1. Check the network cable or connector
556003 to send header to HTTP server.|2. Contact your your network
administrator for further help
Connection is broken and fail |1. Check the network cable or connector
556004 to send data to HTTP server. |2. Contact your your network
administrator for further help
Connection is broken and fail |1. Check the network cable or connector
556005 to receive data from HTTP 2. Contact your your network
server. administrator for further help
The size of received data from |The size of received data is not equal to
HTTP server is wrong. the content length.
556006 1. Check the network cable or connector.
2. Contact your your network
administrator for further help.
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AWIP Errors

557001 Failed to connect to remote Check network envrionment.

App.
557002~ Failed to send file to remote Check network cable and connector.
557005 App. Contact your network administrator for

further help.

System Erro

rs

Reboot your machine. If the problem

150001 Scanner not ready persists, please call service personnel for
help.
Unauthorized network access,
150004 Please login first.
please login first
151004~ Failed to save scanned image
151010 file.
Please try again. If the problem persists,
152004~ Scan parameter error.
please call service personnel for help.
152005
Please restart the product and try again.
152006 Failed to allocate memory. If the error persist, please call service
personnel for help.
152999
Internal error
153001~
153003
Reduce scan reslution or select a
Insufficient memory
153005 different file format. A;termatively,
reduce number of pages to be scanned.
153010
Internal error
153020~
153026 Please restart the product and try again.
153021 If the error persist, please call service
personnel for help.
153022 Scanner busy.
153023~ Internal error
153026
Please restart the product and try again.
Internal error.
170004 If the error persist, please call service

personnel for help.
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Please restart the product and try again.

170005 Send action is stopped If the error persist, please call service
personnel for help.
Failed to send filing report to  |Please check your SMTP settings or
170011
email. contact your network administrator.
171201
Internal error.
172202 Please restart the product and try again.
173204 If the error persist, please call service
175101 Failed to save file into public personnel for help.
folder.
Public folder disk space is not
175102 enough. Contact your network administrator.
175201~  |Failed to save file into public  |pestart the product and try again. If the
175205 folder. error persist, please call service
176003 Internal error. personnel for help.
Public folder disk space is not
177102
enough. Contact your network administrator.
178102
Can not get IP.
179204
Please restart the product and try again.
180001~ Internal error.
If the error persist, please call service
180002
personnel for help.
Please restart the product and try again.
180010 Send action is stopped. If the error persist, please call service
personnel for help.
Please restart the product and try again.
Failed to create thumbnail
182001 If the error persist, please call service
image.
personnel for help.
Please restart the product and try again.
Create thumbnail action is
182002 If the error persist, please call service
stopped.
personnel for help.
Please restart the product and try again.
183006 Internal error.
If the error persist, please call service
185201

personnel for help.
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BM2 and VSL Errors

200100

To use the [BM2] function,
you need to first install
Button Manager V2 onto

your computer.

Check if the PC has installed Button Manager.

200101

VSL disconnect.

Check if the VSL connection on the PC still work.

Scanner Errors

2013 Paperjam Open the front door to remove the jammed
paper.
2014 ADF cover opens Close ADF cover.
2015 ADF no paper. Load aper into the auto document feeder.
2025 Multiple feed Remove paper.
Fan your paper and tray again.
2033 Page skew. Remove paper.
Fan your paper and try again.
2036 Ultrasonic sensor error Restart the device. If the error persists,
contact service personnel.
2040 Fan check error Restart the device. If the error persists,
contact service personnel.
3006 ADF Bottom Head light Restart the device. If the error persists, call
check error. the service to replace the lamp.
3010 ADF Top Head light check Restart the device. If the error persists, call
error. the service to replace the lamp.
3211 Page miss-feed Make sure the edge of your document

slightly touch the paper guides and try again.
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Technical Support

If your problem still exists after trying the above solution, please contact our

technical support.

Headquarter

Avision Inc.

No. 20, Creation Road I, Science-Based Industrial Park,
Hsinchu 300, Taiwan, ROC

TEL: +886 (3) 578-2388

FAX: +886 (3) 577-7017

E-MAIL: service@avision.com.tw

Web Site: http://www.avision.com.tw

US and Canada Area

Avision Labs, Inc.

6815 Mowry Ave., Newark CA 94560, USA
TEL: +1 (510) 739-2369

FAX: +1 (510) 739-6060

E-MAIL: support@avision-labs.com

Web Site: http://www.avision.com

China Area

Hongcai Technology Limited

7A, No.1010, Kaixuan Road, Shanghai 200052 P.R.C.
TEL :+86-21-62816680

FAX :4+86-21-62818856

E-MAIL: sales@avision.net.cn

Web Site: http://www.avision.com.cn

Europe Area

Avision Europe GmbH

Bischofstr. 101 D-47809 Krefeld Germany
TEL: +49-2151-56981-40

FAX: +49-2151-56981-42

E-MAIL: info@avision-europe.com

Web Site: http://www.avision.de
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South American

Avision Brasil Ltda.
Rua Bamboré 41, Vila Monumento, Ipiranga. CEP: 04278-060, Sao Paulo, Brasil

TEL: +55-11-2737-2005
E-MAIL: suporte@avisionbrasil.com.br
Web Site: http://www.avisionbrasil.com.br/
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12 Maintenance

Cleaning the Touch Screen

Wipe the Touch screen Monitor with a wet cloth first then wipe it with a dry cloth.

Touch
screen

Warning:
Do not use liquids, household cleaners, or neutral detergents, as they may
damage the touch screen.

Cleaning the ADF

After using the scanner for a long period of time, the rollers and glass inside the
scanner may become contaminated with ink, toner particles or paper dust. It is
necessary to perform routine cleaning to ensure the optimum image quality and
performance. As a guideline, please clean the rollers and glass after first 4,000
to 5,000 scans and then perform the cleaning on a weekly basis. Note that the

guideline varies according to the type of documents you are scanning.

Tip! If documents do not feed easily, if several documents feed at the same

time or if streaks appear on the scanned images, it is time to clean your scanner.
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The Cleaning Procedures

Soak a clean cloth with some isopropyl alcohol (95%).

1.
2.

Wipe and

Press the ADF Release button to open the front door to the left.

rotate the ADF Roller until the surface is completely removed from dust.

Be careful not to damage the pick

Wipe the rubber part of the ADF pad.

springs.

3.

Your scanner is now ready for use.

Close the scanner front cover.

4.
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Cleaning the ADF Glass

1. Press the ADF Release button. Open the front door to the left.
Wet a clean cloth with some isopropyl alcohol. (95%)

3. Wipe the glass and the white area as illustrated below to rid the dust or dirt.

Cleaning the Flatbed Glass

1. Wet a soft lint-free cloth with some isopropyl alcohol. (95%)

2. Open the document cover as shown below. Gently wipe the surface of the
glass of flatbed.

3. Close the document cover. Your scanner is now ready for use.
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Cleaning the Ultrasonic Sensors

If the scanner sometimes fails to detect multi-feed via ultrasonic sensors, it is
possible that paper dust or dirt may be accumulated on the surface of the
ultrasonic sensors. Please follow these steps to clean the sensors.

1. Press the ADF release button. Open the front door.

2. Wet a clean cloth with some isopropyl alcohol. (95%)

3. Gently wipe the dirt and dust off the surface of the ultrasonic sensors.

Ultrasonic Sensors

Note:
If it is difficult to clean, use a cotton swab.

The availability of ultrasonic sensor varies according to your scanner model.
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Replacing the ADF Reverse Roller

After scanning approximately 100,000 pages through the ADF, the ADF Reverse
Roller may be worn out and you may experience problems with document feeding.
In this case, you may need to replace a new ADF reverse roller. For ordering the
ADF roller, please consult your nearest dealer and follow the procedure below to

replace it.

Disassembling Procedure
1. Press the ADF Release button.
2. Gently open the ADF Front Door to the left.

3. Hold the Reverse Roller Cover with your fingers as shown and place it down.

NREm=

=7
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4. Press the right end of the Friction Roller externally to detach it from the slot
and then detach the left end from its hole.

e .f
[

=

5. Remove rollers from the shaft.

Reassembling Procedure

1. Insert the new rollers to the shaft.

2. Grab the right end of the reverse roller (flat side facing Up) and insert it to its
original place.

@gj Flat side Up

3. Insert the left end of the Reverse Roller to the hole of its original place.

4. Insert the right end of the Reverse Roller to its slot.

1l

1
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5. Close the Reverse Roller Cover.

.N..\\%/w =
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Close the ADF Front Cover.
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Replacing the ADF Roller

After scanning approximately 200,000 pages through the ADF, the ADF rollers
may be worn out and you may experience problems with document feeding. In
this case, you may need to replace a new ADF roller. For ordering the ADF roller,
please consult your nearest dealer and follow the procedure below to replace it.

Disassembling Procedure

1. Press the ADF release button to open the front door.
2. Pull the center of the roller cover to open it.
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4. Move the tab of the ADF roller DOWN as indicated.

5. Detach the right end of the ADF roller from the scanner and remove the
ADF roller.

Assembling Procedure

1. Insert the left end of the ADF roller first to its slot and place the ADF
roller to its proper position.

{“
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3. Pull the belt DOWN.

| I W—H

4. Close the ADF roller cover. A snap-in sound could be heard if correctly
installed.

*Note:

Consumables must be replaced regularly. It is recommended to purchase new
consumables in advance so that they can be replaced before the end of

their life time.

The replacement cycle is based on the use of A4 (80 g/m2 [20 Ib]) wood-free
paper or plain paper. The actual cycle varies according to the type of used
paper and how frequently the scanner is used and cleaned.

Use only the specified consumables.

To purchase consumables, contact the store where you purchased the scanner
or an authorized scanner service provider.
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13 Specifications

All specifications are subject to change without notice.

Items |

Specifications

Model Number : DL-1909H

General Specifications

System Description

Network Scanner

Image Sensor

Contact Image Sensor (CIS)

Light Source

LED Light Bar

Optical Resolution

600 x 600 dpi

Output Resolution

72~1200 dpi (PC Scan)

Output Quality

Input: 48 bits color
Output: 24 bits Color

LCD Size

8 inches

External Connections

1. RJ-45 (for Network connection)
2. USB 3.2 Gen 1X1

Network Connection

RJ-45 Ethernet 10/100/1000 Mb

Output Format

JPEG, TIFF (One-Page TIFF), M-TIFF (Multi-Page
TIFF), PDF (One-Page PDF), *M-PDF (Multi-Page
PDF), Searchable PDF, PDF/A(MPDG), PNG

Dimension (WxDxH)

Min. 689 x 321 x 264 mm (27 x 12.63 x 10.39 in.)
Max. 754 x 321 x 302 mm (29.68 x 12.63 x 11.89 in.)

Weight 6.92 kgs (15.25 Ibs)

Power Requirement 100~240Vac, 50/60Hz

Power Source 24Vdc, 2.0A

Operating Temperature [10°C~35°C

Environment |Humidity 10%~85% RH

Scan Size

ADF Paper Capacity

100 sheets (80 g/m+2 or 20 |Ib. Paper)

ADF Paper Size

50x 50 mm (2 x 2in.) ~ 216 x 356 mm (8.5 x 14
in.)

Paper Thickness

27 ~ 413 g/m2 (7~110 Ibs)
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Network Specification

Connectivity RJ-45 Ethernet 10/100/1000 Mb
Communication IPv4, TCP, UDP, DHCP, SSL/TLS, DNS, DDNS, SNTP,
Protocol LDAP, LDAPS, SMTP, SMTPS, HTTP, HTTPS, MIME,
FTP, FTPS, SMB, Ipsec, 802.1x
Configuration 1. IP address
Requirement 2. Subnet mask
3. Gateway
4. SMTP server
5. FTP server
E-mail Specification
Communication SMTP
Protocol
File Formats
B&W PDF, TIFF, M-TIFF, PNG
Gray/Color PDF, TIFF, M-TIFF, JPEG, PNG

Default File Format |PDF

Separation Limit 1MB, 3MB, 5MB, 10MB, 30MB, Unlimited

Resolution 100, *150, 200, 300, 400, 600 dpi
Default Resolution |200 dpi
Supported Mail Lotus Mail Server 5.0

Server Application |[MS Exchange Server 2000
RedHat 7.0 SendMail
MAC Mail Server in 0S 9.04

Filing Specification

Communication FTP, FTPS, FTPES, SMB, SharePoint
Protocol
File Formats JPEG, TIFF (One-Page TIFF), M-TIFF (Multi-Page

TIFF), PDF (One-Page PDF), *M-PDF (Multi-Page
PDF), Searchable PDF, PDF/A(M-PDF), PNG

Resolution 100, *150, 200, 300, 400, 600 dpi
Max. Number of 50
Filing Profiles
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Wi-Fi Specifications:

Standard IEEE 802.11 b/g/n standards compliant
Wireless LAN 1T1R Mode
Frequency Range 2.412 ~ 2.484GHz ( subject to local regulations)

CCK, DQPSK, DBPSK for DSSS
64QAM, 16QAM, QPSK, BPSK for OFDM

Modulation Type

Modulation Technology DSSS, OFDM

802.11b: up to 11Mbps

Transfer Rate 802.11g: up to 54Mbps
802.11n: up to 72.2Mbps

802.11b: 149.279mW
Output Power 802.11g: 360.579mW
802.11n (HT20): 345.939mW

Antenna PCB antenna

WEP 64/128, TKIP, WPA, WPA2 mixed, 802.1x

Securit
Y and 802.11i
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